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Preface: About this Guide

How to Use this Manual
This Product Reference Guide contains comprehensive basic user instructions for the 
Pegaso Industrial PDA software, batteries, dock, serial cable, data transfer, as well as 
advanced user information such as bar code configuration and parameters. 

This section provides an overview of the manual’s contents and organization.

Document Overview
This document contains the following material:

• This Preface provides an overview of the contents for each chapter, and describes 
document style conventions.

• Chapter 1, "Batteries and Power", discusses checking battery power, power conser-
vation, battery installation, battery charging with a dock or battery charger, battery 
storage, battery disposal, and resetting the mobile computer.

• Chapter 2, "Configuring the Pegaso", uses the control panels to adjust touchscreen 
calibration, date and time, display backlight/contrast, volume/sounds, scanner, 
power, and memory.

• Chapter 3, "Software Applications", covers memory, installing, selecting, using, 
and removing applications, entering data, and using the soft input panel with 
Inbox, Internet Explorer, and Word Pad.

• Chapter 4, "Networks, Communications, and Connections", describes installing, 
setting up, and using ActiveSync, IrDA, and Networking.

• Appendix A, "Accessories", describes the Accessories, such as docks, battery charg-
ers, holsters, and soft cases available for the Pegaso.

• Appendix B, Falcon® Desktop Utility (FDU) allows Datalogic Windows adminis-
trators to configure Windows®CE PDAs and PDTs to control individual user 
access.

• Appendix C, "Configuring the Web Server", describes configuring the Pegaso to 
work with a Web Server. 

• Appendix D, "SNMP Interface", describes SNMP (Simple Network Management 
Protocol) concepts, MIB (Management Information Base) files, and provides addi-
tional resources.

• Appendix E, Cable and Connector Configurations contains pinout information, 
to create standard interface cables for use in interconnecting the Dock to power 
and/or peripheral devices.
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• Appendix F, "Programming Parameters", provides the programmable settings for 
the Pegaso. 

• Appendix G, "Programming Bar Codes", provides bar codes for common setup 
parameters used to program the Pegaso.

• Appendix H, "Glossary", is a glossary of terms used in this manual that you may 
not be familiar with that are specific to Windows®CE and the mobile computer.

Registering Your Datalogic Product
Datalogic values your feedback. Please take a few moments and complete the Product 
Registration form located on our website (www.datalogic.com). Registering your prod-
ucts ensures that you will be informed of the latest product news, technical specifica-
tions, software updates and other future developments from Datalogic.

Document Conventions 
Formatting conventions are used throughout this guide to provide a consistent method 
for representing screen shots, command entries, and keyboard characters. This guide 
also provides special conventions for notes and cautions, information of high interest.

Keystrokes. Filenames, paths, field selections from a pull-down list, and data or key-
strokes entered by the user are shown in this monospaced typeface.

Windows Controls. Windows controls including command bar sequences, prompts, 
dialog boxes, fields, pull-down lists, check boxes and radio buttons are printed in this 
bold typeface.

Portable Keys
Keys on the Pegaso are bracketed by “greater than” and “less than” symbols  
(< >) to distinguish them from keys on the PC.

<F1> — <F19> Keys. The Function keys, such as <F1>, refers only to keys on the 
Pegaso.

NOTES contain information necessary for properly diagnosing, repairing and operating 
the terminal.

CAUTION

The CAUTION symbol advises you of actions that could damage equipment or property.

WARNING

A WARNING symbol calls attention to actions that could result in personal injury.

http://www.datalogic.com
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<ENTER> Key. To differentiate the <ENTER> key on the portable from the Enter key 
on the PC’s keyboard, portable keys are formatted with “greater than” and “less than” 
symbols: <ENTER>.

Stylus Actions 
Stylus actions apply to the Pegaso only; most PCs use a mouse as an input device.

Tap or Select. Tap the display screen once with the stylus to activate a specific button 
or select an item from a pull-down list.

Double-Tap. Tap the stylus twice rapidly in the same location to open an application.

Tap and Hold. Tap and hold the stylus to view the context menu.

Refer to the Quick Start Guide (QSG) for more information on using a stylus with the 
Pegaso.

Mouse Actions 
Applies to the software installation portions of this document using a PC; the Pegaso 
comes equipped with a stylus. Refer to Stylus Actions on page vii, or see the QRG for 
more information.

Click or Select. Press and immediately release the left mouse button without moving 
the mouse. Clicking is used to select specific buttons on various forms and tables.

Double-Click. Click the left mouse button twice in rapid succession. Used to initiate 
an application.

Right Click. Press and hold the right mouse button without moving the mouse.

Select. Click and release the left mouse button to choose an item or items from a pull-
down list.
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Chapter 1
Batteries and Power

Overview
This section contains the following topics:

• "Suspend Mode" starting on page 1-1

• "Battery Warnings and Cautions" on page 1-2

• "Battery Disposal" starting on page 1-3.

Suspend Mode
The Pegaso will go into a suspend or sleep mode when it is idle for a period of time. 
This duration can be customized using the Power control panel (refer to "The Battery 
tab provides power indicators for External power, Main battery, and Backup battery as 
shown in Figure 2-17 on page 2-20. To save your settings, tap OK on the command bar, 
or press <Enter> on the keypad." on page 2-20. Suspend mode works and looks just like 
you have turned the unit off. Press <Power> to suspend (put to sleep) the Pegaso. Press 
<Power> again for the Pegaso to resume its previous state.

Use the Battery Power control panel to set the idle duration and the initiation of suspend 
mode. These features save battery power when the unit is not in use. Refer to "The Bat-
tery tab provides power indicators for External power, Main battery, and Backup battery 
as shown in Figure 2-17 on page 2-20. To save your settings, tap OK on the command 
bar, or press <Enter> on the keypad." on page 2-20 for more information.

Suspending
The following conditions will put the unit into suspend (sleep) mode:

1. When the unit is on, and you press <Power> for 0.5 second to initiate suspend 
mode.

2. When the sleep timer expires, indicating that there has been no use for a specified 
period of time.

3. A discharged battery pack.
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Resuming
Use one of the following methods to resume (wake up the Pegaso): 

• Press <Power> to resume (wake up).

• Put the Pegaso into a dock.

• Press the Scan Trigger to wake up the unit (handled version only).

When a battery pack is fully discharged while the unit is in suspend mode, the Pegaso 
remains in the suspended mode until the battery pack is charged or external power is 
supplied via the dock or a power cable.

Battery Warnings and Cautions

WARNING

Do not discharge the battery using any device except for the Pegaso. When the battery is 
used in devices other than the Pegaso, it may damage the battery or reduce its life expect-
ancy. If the device causes an abnormal current to flow, it may cause the battery to become 
hot, explode or ignite and cause serious injury.

Lithium-ion battery packs may get hot, explode or ignite and cause serious injury if 
exposed to abusive conditions. Be sure to follow the safety warnings listed below:

• Do not place the battery pack in fire or heat.
• Do not install the battery pack backwards so the polarity is reversed.
• Do not connect the positive terminal and negative terminal of the battery pack to each 

other with any metal object (such as wire).
• Do not carry or store the battery pack together with metal objects.
• Do not pierce the battery pack with nails, strike it with a hammer, step on it or otherwise 

subject it to strong impacts or shocks.
• Do not solder directly onto the battery pack.
• Do not expose the battery pack to liquids, or allow the battery to get wet.

In the event the battery pack leaks and the fluid gets into your eye, do not rub the eye. 
Rinse well with water and immediately seek medical care. If left untreated, the battery fluid 
could cause damage to the eye.
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Battery Disposal 
If you must dispose of a battery pack, please follow the CAUTIONS below: 

Please reference your local regulations for any further guidelines about battery disposal. 

CAUTION

Always charge the battery at 32°–104°F (0°–40°C) temperature range. Regularly charging 
near the temperature limits will increase the time necessary to fully charge the battery, and 
will shorten the battery’s useful life.

If you remove the battery pack or it becomes completely discharged, there is a 30-minute 
window in which to insert a charged battery pack before the backup battery fails. If your 
backup battery completely discharges, the contents of the RAM memory will be lost. If your 
back-up battery is less than fully charged, there is a proportionally smaller time available.

Use only the authorized power supplies, battery pack, chargers, and docks supplied by 
your Datalogic reseller. The use of any other power supplies can damage the Pegaso and 
void your warranty. Refer to Appendix A for the correct "Power Supplies" and "Accesso-
ries". 

Do not disassemble or modify the battery. The battery contains safety and protection 
devices, which, if damaged, may cause the battery to generate heat, explode or ignite.

Do not place the battery in or near fire, on stoves or other high temperature locations. Do 
not place the battery in direct sunlight, or use or store the battery inside unventilated areas 
such as cars in hot weather. Doing so may cause the battery to generate heat, explode or 
ignite. Using the battery in this manner may also result in a loss of performance and a 
shortened life expectancy.

Do not place the battery in microwave ovens, high-pressure containers or on induction 
cookware.

Immediately discontinue use of the battery if, while using, charging or storing the battery, 
the battery emits an unusual smell, feels hot, changes color or shape, or appears abnormal 
in any other way. 

Datalogic recommends annual replacement of rechargeable battery packs to ensure maxi-
mum performance under normal use. If battery pack has heavy use (requires charging 
more than once a day), it is recommended that batteries be replaced at 6-month intervals. 

CAUTION

Use only a battery pack supplied by a Datalogic reseller for this device.The use of other 
battery supplies can damage the Pegaso and void your warranty. Contact your reseller to 
for the correct power supplies; view your options under "Battery Pack" on page A-2. 

CAUTION

When the battery pack is worn out, insulate the battery pack terminals with adhesive tape 
or similar materials before disposal.

 Recycle Lithium-Ion Batteries.

 Do not throw Lithium-Ion Batteries in the trash
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Chapter 2
Configuring the Pegaso

Overview
This section contains the following topics on configuring 
your Pegaso. Most control panels are accessed by selecting/
tapping Start > Settings > Control Panel.

• "Backlight" on page 2-2

• "Bluetooth Manager" on page 2-3 (optional)

• "Certificates" on page 2-6

• "Date and Time" on page 2-6

• "Decoding" on page 2-7

• "Device Info" on page 2-11

• "Display Configuration" on page 2-11

• "Error Reporting" on page 2-12

• "Falcon Config" on page 2-13

• "Input Panel Properties" on page 2-13

• "Internet Options" on page 2-14

• "Keyboard Configuration" on page 2-16

• "Network and Dialup" on page 2-17

• "Owner" on page 2-18

• "Password" on page 2-18

• "PC Connection" on page 2-19

• "Persistent Registry" on page 2-19

• "Power Configuration" on page 2-20

• "Regional Settings" on page 2-21

• "Remove Programs" on page 2-22 

• "Storage Manager" on page 2-22

• "Stylus Calibration" on page 2-22

• "System Properties" on page 2-24

• "Volume and Sounds" on page 2-25

• "Wi-FI" on page 2-26

Control Panel
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Backlight 

Select Start > Settings > Control Panel > Backlight to open the Backlight control panel. 

Brightness

1. On the Brightness tab (refer to Figure 2-1), use the slider to adjust the brightness 
to the desired setting. You can also use the <UP> and <DOWN> arrow keys to adjust 
this setting.

2. Auto Power-Save dims (rather than turning off ) the backlight after 15 seconds of 
inactivity. This features does not change the behavior of the Auto-Off Settings. 
(Refer to "Power Configuration" on page 2-20).

3. The ambient light sensor automatically adjusts the intensity of the backlight on 
the display and keypad in response to changes in lighting conditions. Select the 
check box to enable or disable this feature. 

Figure 2-1. Backlight Control Panel & Brightness 

Auto-Off
On the Auto-Off tab, enable the desired option checkbox and select the desired options 
from the pull-down lists (refer to Figure 2-1).

Increasing backlight brightness can cause the battery pack to discharge at a faster rate. 
The battery discharge rate slows with a decrease in backlight usage.
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Activation

1. On the Activation tab, just tap the checkbox(es) to enable or disable them (refer to 
Figure 2-1): 

• Set the backlight to turn on automatically when any key is pressed or the touch-
screen is tapped, either while on battery or external power.

• Turn on the backlight when the trigger is pulled.

• Deselect Launch Control Panel from the Keyboard to turn off the ability to 
open the Backlight control panel with a key sequence.

2. To exit and save your modifications, tap OK on the command bar, or press <Enter> 
on the keypad.

Bluetooth Manager

Search for device

1. Select Start > Settings > Control Panel > Bluetooth Manager to open the Bluetooth con-
trol panel.

2. Search for the type of Device(s) you want to connect to by tapping Printer, Serial, or 
All. The Pegaso will search for Bluetooth Devices within range.

3. If you attempt to set up a connection when the Bluetooth Radio is disabled, you 
will receive a message reminding you that the radio is turned off, and asking you if 
you want to turn it on. Tap Yes if you need to enable the Bluetooth Radio.

Once searching is complete, Bluetooth Device Profiles will be displayed in the Discov-
ery tab. You can set up a connection to a device on the list, or clear it from the list by 
tapping the Clear button.

Using Auto-on while running from battery power will cause the battery pack to discharge 
at a faster rate. The battery discharge rate decreases with a decrease in backlight usage.
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Figure 2-2. Searching for a Bluetooth Device

Connect to a Bluetooth Device

1. From the list of available devices, double tap the one you want to activate, or select 
and then tap Connect. 

2. The resulting dialog will display services that are available on the device. 

Select the service you want to connect to. The following table shows the icons that dis-
play for different types of service. 

Figure 2-3. Bluetooth Device Icons

Icon Service

Dialup Networking

Printer

File Transfer Protocol (FTP) Object Exchange (OBEX)

Object Push (OPP) Object Exchange (OBEX)

ActiveSync

Human Interface Device (HID) - Keyboard

Serial
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Virtual Port allows you to specify the incoming port, which is used to communicate seri-
ally with an incoming device just as if it were a physical COM port. This option is avail-
able only if you have selected a Printer or Serial service. 

You can also select Encrypt or Authenticate from the Bluetooth control panel to apply or 
modify those settings. 

1. To require Authentication, tap the checkbox, then 
tap OK. 

2. The Authentication Request dialog will then 
open, requesting that you enter a PIN. Use the 
Input Panel to type in the PIN.

3. Tap OK to complete.

The dialog will also appear when an Authentication 
request is received from another device.

Viewing or Deleting Paired Devices
Once you have set up a Pairing, you can view the settings by double-tapping its name 
from the Connections tab. Tap the arrow to change the Virtual Port, or Delete to 
remove the device pairing. Tap Sync to initiate a Sync (available only if the service is an 
ActiveSync connection).

Figure 2-4. Bluetooth Pairing Info

The icons displayed in the taskbar at the bottom of your Pegaso’s screen will show you 
the state of the Bluetooth connection, as shown in Table 2-1.
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Table 2-1. Bluetooth taskbar icons

Settings
The Settings tab allows you to enable or disable the Bluetooth radio and specify settings 
for Incoming Connections.

Tapping Find Me will make the Pegaso available to other Bluetooth devices for 60 sec-
onds, allowing them to set up a connection.

Tap Apply to apply the settings you have selected.

Certificates
Certificates are used by some applications for establishing trust and to secure communi-
cations. See the Microsoft Windows CE help on your unit for further information 
about Certificates.

Date and Time 
In this control panel, you can change the year, month, date, time, time zone, or select 
automatic adjust for Daylight Savings Time. To set or change the date and time:

Icon Name Description

Disabled Icon Indicates that the Bluetooth has been disabled.

Unpaired Icon
Indicates that the Bluetooth radio is on but the device 
is currently not paired to another.

Paired Icon
Indicates that the Bluetooth radio is on and the 
device is paired with at least one other device.

Discoverable
Indicates that the device is discoverable by other 
Bluetooth devices.
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1. Select Start > Settings > Control Panel > Date/Time. 

2. Select the month to open a pull-down list of 
months or tap the arrow buttons on either side of 
the month to increase or decrease the month. 

3. To change the year, select the year to open a 
numeric dial. Select the up arrow to increase the 
value; select the down arrow to decrease the 
value. Or you can type a new year value in the 
field.

4. To change the time, select the hour, minute, sec-
onds, or AM/PM and select the up arrow to 
increase the value; select/tap the down arrow to decrease the value. Or you can 
type a new time value in the field.

5. Select your correct time zone from the pull-down list.

6. To automatically adjust the clock for Daylight Savings Time, enable the checkbox 
at the bottom of the screen.

7. Select Apply to save your changes and make additional modifications. 

• Select OK to save your changes and exit Date/Time Properties.

• Select/tap the close button to exit without saving your changes.

Decoding
You can configure the Pegaso’s decoding options by tapping on Start > Settings > Control 
Panel > Decoding. Decoder configuration can also be accomplished for large numbers of 
terminals using FMU (Falcon Management Utility).

There are two sections in the Decoding control panel, each containing additional pages. 
There are six General Configuration pages and multiple Bar Code symbology pages.

Configuration Control Panels
Select the desired configuration from the following options shown in Figure 2-5, and 
the other Decoding Properties figures on the following pages.

Use the pull-down menus or tap the left and right arrow keys to navigate the different 
pages of the Configure utility.

Other decoding parameters are described in Programming Parameters, starting on 
page F-1; bar code settings are provided in Programming Bar Codes, starting on 
page G-1.
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Figure 2-5. Decoding Properties: Audio

• Audio: Sets volume, tone, duration, and number of various types of beeps.

Figure 2-6. Decoding Properties: General Options

• General Options: Select from Label Programming Enable, Symbology IDs, Label 
Prefix, Label Suffix, and Data Separator options.

To view other configuration options, select Configure > General from the menu.
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Figure 2-7. Decoding Properties: Decoding Options

• Decoding Options: Set the User ID character associated with a symbology, the Redun-
dancy and select Aggressive Decoding when available.

Figure 2-8. Decoding Properties: Devices

• Devices: Enable the keyboard wedge for bar code scanner, Magnetic Stripe Reader, 
RFID, and enable Read-Ahead for attached devices.

Bar Code Symbology Pages
Use the pull-down menus from Configure > 1D Bar Code, or tap the left and right arrow 
keys to navigate the different pages of the bar code symbology pages. Each bar code 
symbology opens to its own page, as shown in Figure 2-10 on page 2-10. 

To view other configuration options, select Configure > General from the menu.

To view other configuration options, select Configure > General from the menu.
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Figure 2-9. Available 1D Bar Code Symbologies

Refer to the sample symbology control panels in Figure 2-10 for examples of the types 
of fields and options you can modify.

Figure 2-10. Common Symbologies: Code 39 and UPC-A 

• Code 39: Select from enable, min/max lengths, enable checksum, send checksum, 
and Full ASCII conversion.

• UPC-A: Select from Enable, Send Check Digit, and Send System Digit.

Codabar Pharmacode 39
Code 39 RSS-14
Code 93 RSS-Limited
Code 128 RSS-Expanded
EAN-13 Standard 2/5
EAN-8 Trioptic
Interleaved 2/5 UPC-A
Matrix 2/5 UPC-E
MSI UPC/EAN Extensions
See Appendix G for details on parameters 
available for each symbology.

Decoding parameters are described in Programming Parameters, starting on page F-1; 
bar code settings are provided in Programming Bar Codes, starting on page G-1.

Other decoding parameters are described in Programming Parameters, starting on 
page F-1; bar code settings are provided in Programming Bar Codes, starting on 
page G-1.
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Device Info
Select Start > Settings > Control Panel > Device Info to view the device serial number, model 
number, firmware version, and keyboard type.

The serial number is also displayed on a label inside the Battery compartment, as shown 
in Figure 2-11.

Figure 2-11. Serial Number Locations

Display Configuration
To change the default Background or Appearance (Windows Color Scheme), select Start 
> Settings > Control Panel > Display.

Background
To change the Background image:

1. Select Start > Settings > Control Panel > Display. 

2. Place a new image in the Windows directory. 
This file must be exactly 480 pixels wide by 
640 pixels high.

3. The current file is located in the Windows 
directory with the Datalogic logo file named  
DeskLogo.bmp.

4. Select the new file name by using Browse.

Serial
Number
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Appearance
To change the default Windows color scheme:

1. Tap the Appearance tab.

2. Tap the Scheme pull-down list and select a new 
Windows color scheme if desired. 

3. Tap OK on the control bar, or press <Enter> on 
the keypad.

Settings
To change the Display settings:

1. Tap the Settings tab.

2. Select the desired Rotation using the radio but-
tons. 

3. Change the Resolution by selecting the desired 
setting.

4. Tap OK on the control bar, or press <Enter> on 
the keypad.

Error Reporting

1. Select Start > Settings > Control Panel > Error Reporting
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2. Enable or disable error reporting and related 
features by tapping on the desired selections.

3. Tap OK on the control bar, or press <Enter> on 
the keypad.

Falcon Config
Tap Start > Settings > Control Panel > Falcon Config to access configuration utilities such as 
the Falcon Management Utility (FMU) and Falcon Desktop Utility (FDU) settings. See 
"Falcon® Desktop Utility for Windows® CE", starting on page B-1, for complete 
information on FDU. 

Falcon Management Utility (FMU)
The Falcon Management Utility (FMU) is the easiest method to use to configure multi-
ple units, especially if you have an enterprise-wide deployment. A copy of FMU is 
shipped with all Pegaso Windows CE units. For complete information on FMU, refer to 
the FMU User’s Guide on the Product CD included with your Pegaso.

Input Panel Properties
To change the Soft Input Panel settings:

1. Select Start > Settings > Control Panel > Input 
Panel.

2. Change the desired settings.

3. To change the Soft Keyboard Options, tap 
Options.

4. Change the soft keyboard options as desired, 
selecting from:

• Large or small keys.

• Using gestures for space, backspace, shift, and enter.
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5. To exit the Soft Keyboard Options, tap OK on the 
control bar, or press <Enter> on the keypad.

6. To exit Input Panel settings, tap OK on the con-
trol bar, or press <Enter> on the keypad.

Internet Options
To change the Internet default settings:

1. Select Start > Settings > Control Panel > Internet Settings.

2. On the General tab (refer to Figure 2-12A), type in the URL of the desired start 
page and the desired search engine. You can also select a User Agent, change the 
Cache Size, clear the Cache, and clear the History.

3. On the Connection tab (refer to Figure 2-12B) modify the network access settings 
as desired.

Figure 2-12. Internet Settings 

4. On the Security tab (refer to Figure 2-13A) add sites or modify the security settings 
for Internet, Local intranet, Trusted Sites, and Restricted Sites. 

B.A.
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Figure 2-13. Internet Settings 

5. The Privacy tab (refer to Figure 2-14) allows you to modify the settings by tapping 
the radio buttons. You can Accept, Block or receive a Prompt for First-party and 
Third-party Cookies. Enable/Disable session cookies by selecting/deselecting the 
check box.

Figure 2-14. Internet Privacy Settings 

6. On the Advanced tab (refer to Figure 2-15A) modify the advanced settings for 
Accessibility, Browsing, Multimedia, and Security by tapping the check boxes.

B.A.
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Figure 2-15. Advanced Internet and Popup Settings

7. The Popups tab provides options for blocking popups, to display notification 
when popups have been blocked, and to open new pages in the current window. 

8. To exit Internet Settings, tap OK on the control bar or press <Enter> on the keypad.

Keyboard Configuration 
1. Select Start > Settings > Control Panel > Keyboard Options to open the Keyboard con-

trol panel.

2. Adjust the slider for Multi-Tap Timeout to match your personal preferences. Use the 
box provided to test the timeout delay.

3. Click the Load Map tab to select a keyboard keymap by browsing, or click the but-
ton for Default Map. Use the box provided to test the current keyboard mapping. 

4. Use the Triggers tab to define the behavior of each Trigger by selecting it from the 
drop-down box, then clicking the desired option. Available items will vary 
depending on the model.

5. Tap OK to exit the Keyboard Options control panel.

A. B.
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Network and Dialup
To change the Network and Dialup connection settings, complete these steps:

1. Select Start > Settings > Network and Dialup Connections.

Figure 2-16. Changing the Network & Dialup Connection Settings. 

2. Double-tap the connection to view or change the settings. The SDCCF10G1 item 
shown as an example can vary, depending on the radio installed and the number of 
connections.

3. Complete the two tabs as shown in Figure 2-16: 

• IP Address: Select DHCP or set static IP settings.

• Name Servers: If using static IP, set DNS and WINS servers.



Configuring the Pegaso

2-18 Pegaso™ Industrial PDA with Windows® CE

Owner
To change the Owner default settings:

1. Select Start > Settings > Control Panel > Owner 
Properties. The Input Panel opens to facilitate 
entering data.

2. Enter data using the input panel or the keypad 
on the PDA.

3. To exit the Owner Properties control panel, tap 
OK on the control bar, or press <Enter> on the 
keypad.

For more information on using the Network ID tab, 
refer to "Setting up the Network ID" on page 4-8.

Password
To change the Password default settings:

1. Select Start > Settings > Control Panel > Password 
Properties. 

2. Enter the desired password twice as indicated 
in the two fields.

3. Select to enable password protection at power-
on and/or enabling password protection for 
the screen-saver.

4. To exit the Password control panel, tap OK on 
the control bar, or press <Enter> on the keypad.
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PC Connection
The PC Connection control panel determines how ActiveSync works with the PDA. To 
modify the default settings: 

1. Select Start > Settings > Control Panel > PC Con-
nection. 

2. Select the first checkbox to enable direct con-
nections to the desktop computer.

3. Tap Change Connection to modify the connec-
tion method from USB or Serial.

4. To exit the Change Connection dialog, tap OK 
on the control bar, or press <Enter> on the key-
pad.

5. To exit the PC Connection Properties control 
panel, tap OK on the control bar, or press <Enter> on the keypad.

Persistent Registry
Persistent Registry saves the RAM-based registry to 
persistent storage. 

1. Tap Persist to persist the registry. 

2. Tap Persist registry settings to automatically 
persist the settings at the time specified in the 
dropdown box

3. Tap Clear to delete all persistent registry files 
from the Flash FX disk. 

Automatically persisting the registry at frequent intervals may slow system performance.
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Power Configuration
To adjust power management settings, select Start > Settings > Control Panel > Power. Use 
this control panel to check the charge on the battery or to change the Power settings.

Battery Tab
The Battery tab provides power indicators for External power, Main battery, and Backup 
battery as shown in Figure 2-17 on page 2-20. To save your settings, tap OK on the com-
mand bar, or press <Enter> on the keypad.

Schemes Tab 
The Schemes tab allows you to switch the power scheme and specify the Idle settings for 
User (in 1-minute increments) or System (in 5-minute increments). You can also specify 
Suspend settings in 5-minute increments). To save your settings, tap OK on the com-
mand bar, or press <Enter> on the keypad.

Device Status Tab
The Device Status tab displays the power usage of active devices.

Figure 2-17. Battery and Power Tabs 
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Regional Settings
To change the Regional Settings defaults, select Start > Settings > Control Panel > Regional 
Settings. 

1. Select your locale from the spin box. See Figure 2-18 on page 2-21. 

2. Review the Appearance Samples in the bottom half of the screen. Click Customize 
to change the appearance of Number, Currency, Time, and Date.

Figure 2-18. Region and Custom Settings

3. The options on the Language tab are disabled because the Pegaso will display only 
in English. 

4. The Input Panel will open to facilitate data input.

Figure 2-19. Language and Input Tabs 

5. To exit Regional Settings, tap OK on the control bar, or press <Enter> on the keypad.
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Remove Programs
See "Removing Programs" on page 3-7.

Storage Manager
To change the Storage Manager control panel default settings:

1. Select Start > Settings > Control Panel > Storage 
Manager. 

2. From the Store Info pull-down list, select the 
desired storage device.

3. You can also format, dismount, and create par-
titions on storage devices using this control 
panel.

4. To save and exit the Storage Manager control 
panel, tap OK on the control bar, or press 
<Enter> on the keypad.

Stylus Calibration
You might need to recalibrate the touch screen (i.e. when you attempt to select one item 
with the stylus, another item is erroneously selected).

To recalibrate the touch screen, complete the following steps:

1. Select Start > Settings > Control Panel > Stylus to open the Stylus Properties dialog as 
shown in Figure 2-20 on page 2-23.

2. Adjust Double-Tap sensitivity if needed or desired.

3. Select the Calibration tab to open the Calibration application.

CAUTION

Dismounting or formatting the persistent storage drive will erase all files and programs 
stored in Memory.
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Figure 2-20. Stylus Properties Control Panel

4. Tap Recalibrate to open 
the Calibration screen 
shown to the right

5. Carefully press and 
briefly hold stylus on 
the center of the target 
as the target moves 
around the screen or 
press <ESC> to cancel 
the stylus calibration.

For more information about 
the touch-sensitive display, 
refer to “Using the Stylus” 
and “Navigating the Display” 
in the Quick Start Guide (QSG).
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System Properties 
Refer to the System control panel for information related to the system.To view the Sys-
tem properties, select Start > Settings > Control Panel > System Properties.

General Tab 
To view the expansion card settings, select Start > Set-
tings > Control Panel > System Properties > General tab.

Memory Configuration

RAM Memory Allocation and Usage

Complete the following steps to adjust the Memory 
Allocation (RAM Memory):

1. Select Start > Settings > Control Panel > System 
Properties.

2. Select the Memory tab.

3. Move the slider to adjust memory allocation.

4. Tap OK, or <Enter> on the Pegaso.
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Device Name
Your device uses this information to identify itself to 
other computers.

Copyrights
Refer to this tab for specific copyright data. As a 
user, you are responsible to read this statement.

Volume and Sounds
To change the Volume and Sound settings, complete the following steps:

1. Select Start > Settings > Control Panel > Volume & Sounds Properties to open the Vol-
ume settings.
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Figure 2-21. Volume and Sounds Control Panels

2. Set the volume by adjusting the slider from Soft to Loud.

3. Enable the desired sounds for key clicks, screen taps, notifications, and applica-
tions.

4. Select the Sounds tab to choose from various wave files in the menu.

5. You can listen to the sound by selecting Preview.

6. Save your new sound scheme by selecting Save As and entering a name for your 
new Sound Scheme in the field. Delete a sound scheme by tapping Delete. 

7. Tap OK when finished modifying your volume and sounds properties.

Wi-FI

Using the Summit Client Utility
The Summit Client Utility (SCU) is an application designed for end users and adminis-
trators of mobile devices that use a Summit radio module. For further information 
beyond the scope of this manual, you can download the complete Summit User’s Guide 
from www.summitdatacom.com.

Reference the QRG for details about the basic functions of this utility. After completing 
an administrator login to the utility, you can perform these additional tasks:

• Create, rename, edit, and delete profiles

• Alter global settings, which apply to every profile

SCU provides a graphical user interface (GUI) for access to all of its functions. Access to 
these functions also is available through an application programming interface (API), 
which an application programmer can use to enable another utility to manage the radio.

http://www.summitdatacom.com
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To initialize SCU:

1. Go to Start> Settings > Control Panel. 

2. Tap on the Wi-fi icon. 

SCU Windows
SCU has five tabs: Main, Profile, Status, Diags (Troubleshooting), and Global Settings. 
Tabs enable easy navigation. Each tab is described in more detail in this section. 

Main Tab
Reference Figure 2-22 on page 2-27 to view the features of the Main tab.

• Enable/Disable Radio: Select or deselect to enable or disable the radio.

• Active Profile: Displays the name of the active configuration profile. An administra-
tor can use the selection list to select a different profile. 

• Association Status: Indicates if the radio is associated to an access point and, if not, 
what the radio’s status is.

Figure 2-22. Main tab 

• Regulatory Domain: Indicates the regulatory domain or domains for which the 
radio is configured. “Worldwide” means that the radio can be used in any domain. 
The domain cannot be configured by an administrator or user.

• Software Versions: Indicates the version of the device driver and the version of SCU 
that are running on the device.

• About SCU: Supplies information on SCU.

Profile Tab
Profile settings are radio and security settings that are stored in the registry as part of a 
configuration profile. When a profile is selected, its settings become active. An adminis-
trator can define, edit, or delete up to 20 profiles in the Profile tab in SCU. Profile 
changes made are saved only when the Commit button is pressed.

Enable/Disable 

Active Profile
Association Status

Regulatory Domain
Software Versions

About SCU

Tabs
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Figure 2-23 on page 2-28 is an example of a Profile tab. Here are the highlights:

• Profile: Use to select the profile to be viewed or edited. If “ThirdPartyConfig” is 
selected then, after the device goes through a power cycle, WZC is used for config-
uration of the radio.

• Actions: Four actions are available to an administrator:
- Rename: Give the profile a new name, one that is not assigned to another pro-

file

- Delete: Delete the profile, provided that it is not the active profile

- New: Create a new profile with default settings and give it a name (and then 
change settings using other selections on the tab)

- Commit: Ensure that changes to profile settings made on the tab are saved in 
the profile

Figure 2-23. Profile tab

3. Radio attribute and setting: Attributes in the list box can be selected individually. 
When an attribute is selected, the current setting or an appropriate selection box 
with the current setting highlighted appears on the right. For example, selecting 
SSID causes an edit box to appear; selecting transmit power causes SCU to display 
a drop-down list box with available settings.

4. Security settings: The items at the bottom of the tab enable the administrator to 
configure the settings for EAP Type (used for 802.1X authentication) and Encryp-
tion.

To connect a Summit radio to a typical business WLAN, you must select a profile that 
specifies the SSID, EAP type, and encryption type supported by the WLAN:

• SSID: The name or identification of the WLAN.

• EAP type: The protocol used to authenticate the device and its user if the WLAN 
uses the Enterprise version of Wi-Fi Protected Access (WPA) and WPA2. SCU 
supports four EAP types: PEAP with EAP-MSCHAP (PEAP-MSCHAP), PEAP 
with EAP-GTC (PEAP-GTC), LEAP, and EAP-FAST 

Profile
Actions

Radio Attributes & Settings

Security Settings
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• Encryption: Specifies the type of key used to encrypt and decrypt transmitted data 
and how that key is specified or derived. Encryption options include:

- WPA2 or WPA with dynamic keys (derived from the EAP authentication pro-
cess)

- WPA2 or WPA with pre-shared keys

- Static WEP keys

Consult the Summit User’s Guide for details on all profile settings, including security 
settings.

Status Tab
The Status tab shown in Figure 2-24 on page 2-29 provides status information on the 
radio. Status items include IP address and MAC address for the client radio, IP address 
and MAC address for the AP, signal strength, channel, transmit power, and data rate. A 
sample Status tab is shown in Figure 2-24 on page 2-29.

• Client info: Name of active profile, client name, client IP address, and client MAC 
address

• AP info: AP name, AP IP address, and AP MAC address

• Connection info: Channel, transmit power, and bit rate

One status item, the radio association state, is shown on both the Status tab and the 
Main tab. Potential values are: Down (not recognized), Not Associated, Associated, or 
[EAP type] Authenticated.

Figure 2-24. Status tab

Diags Tab
A sample Diags, or troubleshooting, tab is shown in Figure 2-25 on page 2-30. 

Client 

AP info

Connection 
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Figure 2-25. Diags tab, with ping active

Here are the functions available on the Diags tab:

• (Re)connect: Disable and enable the radio, apply or reapply the current profile, and 
attempt to associate and authenticate to the wireless LAN, logging all activity in 
the output area at the bottom.

• Release/Renew: Obtain a new IP address through DHCP release/renew, and log all 
activity in the output area at the bottom.

• Start Ping: Start a continuous ping to the address in the edit box next to it. Once 
the button is clicked, its name and function will change to Stop Ping. Leaving the 
Diags tab also will stop the ping, as will pressing any other button on the screen.

• Diagnostics: Attempt to (re)connect to an AP, and provide a more thorough dump 
of data than is obtained with (Re)connect. The dump will include radio state, pro-
file settings, global settings, and a BSSID list of APs in the area.

Global Settings Tab
Global settings include:

• Radio and security settings that apply to all profiles

• Settings that apply to SCU itself

An administrator can define and change most global settings on the Global Settings tab 
in SCU. Figure 2-26 shows a sample Global Settings tab.

Ping address

Ping results
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Figure 2-26. Global Settings 

The default setting for each global setting ensures reliable operation in most environ-
ments. Consult the user’s guide for details on all global settings.



Configuring the Pegaso

2-32 Pegaso™ Industrial PDA with Windows® CE

NOTES
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Chapter 3

Software Applications

Overview
This section contains the following topics:

• "Inbox" starting on page 3-2.

• "Internet Explorer" starting on page 3-2.

• "Media Player" on page 3-3.

• "WordPad" starting on page 3-3.

• "Persistent Memory" starting on page 3-4

• "Installing Programs" starting on page 3-5.

• "Using an Installation Wizard" starting on page 3-6.

• "Installing Programs Manually" on page 3-6.

• "Using Windows Explorer to Add to the Start Menu" on page 3-7.

• "Using ActiveSync to Add to the Start Menu" on page 3-7.

• "Removing Programs" starting on page 3-7.

• "Firmware Update Utility" on page 3-8.

• "Retrieving a Firmware Image Update" on page 3-8.

• "Installing FUU on the Host PC" on page 3-8.

• "Updating the Pegaso Firmware" on page 3-10.

• "Restoring Pegaso Firmware" on page 3-11.

• "AutoStart" on page 3-12.
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Inbox
The Pegaso comes with Inbox for Windows CE installed from the factory. Inbox is a 
familiar Microsoft email interface. To set up your Inbox:

1. Open Inbox by selecting Start > Programs > Inbox.

2. Select Services > Options from the command bar 
to configure email.

3. Drag the screen to show Add.... Select Add....

4. Select the Service Type and type the email service 
name in the Service Name text box. Select OK.

5. Enter the server and user information in the Mail 
Service Definition.

6. Configure your inbox using the Mail General Pref-
erences dialog.

7. Configure your mail retrieval settings in the Mail Inbox Preferences.

8. Tap OK to complete the Inbox configuration.

9. Select Services > Connect from the command bar.

10. Select Services > Send/Receive Mail from the command bar to manually retrieve 
mail. Pending email appears in the inbox after connecting. 

Internet Explorer
The Pegaso comes with Internet Explorer for Windows 
CE installed. 

1. Open Internet Explorer by selecting Start > Pro-
grams > Internet Explorer.

2. To set a default home page, navigate to the 
desired default web page.

3. Select View > Internet Options from the com-
mand bar.

4. Enter the desired URL in the Start Page field.

5. Tap OK.
Internet Explorer window with the 
Status bar and View menu.
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Internet Explorer uses sliding menus for application 
and navigation control. Tap and drag the sliding 
menus to the left or right to see the hidden menu 
items and toolbars. 

To achieve more screen real estate in Internet 
Explorer, you can hide the Status bar and View menu. 
From the top menubar, go to View > Hide Toolbars. 

Once it is hidden, you must reset the Pegaso to 
access these features again. Refer to the Pegaso Quick 
Start Guide (QSG) for reset instructions.

For more control over the way Internet Explorer is 
displayed, refer to "Falcon® Desktop Utility for 
Windows® CE", starting on page B-1

Media Player
The Pegaso comes with Media Player for Windows CE 
installed.

1. Open Media Player by selecting Start > Programs > 
Media Player.

2. Select File > Open to open an available existing 
media file. 

3. Please refer to www.microsoft.com for additional 
information and help with your Microsoft Win-
dows Media Player.

WordPad
The Pegaso comes with WordPad for Windows CE 
installed from the factory. The following text and doc-
ument file types are compatible with WordPad:

• Text (*.txt)

• Word Document (*.doc)

• Rich Text File (*.rtf )

• WordPad (*.pwd)

When file types other than *.pwd are transferred to 
the device, Windows CE translates the files into a 
compressed file type.

To start WordPad, select Start > Programs > Microsoft 
WordPad.

Internet Explorer window with the 
Status bar and View menu hidden.

http://www.microsoft.com
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Persistent Memory 
In addition to the RAM-based storage standard on Windows CE terminals, the Pegaso 
is also equipped with a persistent storage application and file storage area.

Saving to Persistent Memory
To save an application or data to the persistent memory, from your current application 
select File > Save As > and navigate to the location as described below.

Location
To access the contents of Persistent Memory:

1. Double-tap the My Device icon on the desktop.

2. Double-tap the FlashDisk icon to view.

Figure 3-1. Location of the FlashDisk 

The persistent storage memory persists across all reset (warm/cold reboot) conditions 
and software/firmware updates. 

Because of this, Datalogic very strongly recommends installing all applications, applets, 
programs, and important data files to the persistent disk of the Pegaso.

CAUTION

If an application or a data file is only installed or saved in RAM, a hard reset may result in 
the loss of that application or data file.
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Disk Size
The size of the persistent storage disk will vary, depending upon several factors, such as 
the size and number of currently running applications and the amount of memory cur-
rently consumed by the OS.

To view the current size of flash memory:

1. Double-tap the My Device icon on the desktop. (See Figure 3-1). 

2. Press and hold the FlashDisk directory with the stylus, and select Properties from 
the pop-up menu.

3. The FlashDisk Properties dialog opens. The number following Free is the amount 
of memory currently available on the Pegaso.

Table 3-1. Persistent Memory Specifications

Installing Programs
Programs pre-installed on the Pegaso are stored in ROM (read-only memory). You can-
not remove or modify this software. 

You may add programs and data files to RAM (random access memory) or into persis-
tent storage memory via the persistent storage disk. You can install *.cab, *.exe 
*.zip files, or other files designed for the Pegaso.

Please follow the directions provided with the software to install it.

Persistent Memory Specifications

Total Flash size 128 MB
OS/Firmware uses 32 MB
FlashDisk size 96 MB
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Using an Installation Wizard
If the file has an installer, the installation wizard begins automatically if you have Active-
Sync installed. Most installation programs require an ActiveSync connection. (Refer to 
"Installing & Setting Up Microsoft ActiveSync" on page 4-1.)

Follow the directions on the screen. Once the software is installed on your desktop com-
puter, the installer transfers the software to your Pegaso.

Installing Programs Manually
To quickly install programs on multiple units, use the Falcon Management Utility 
(FMU). For more information, refer to page 2-13. 

If the file does not contain an installer, an error mes-
sage indicates the program is valid but is designed 
for a different type of computer. 

• Install *.cab, *.exe *.zip, setup.exe 
files, or other files designed for the Pegaso. 

• Many Windows CE applications will also 
work on the Pegaso.

Start by downloading the program to your desktop 
computer (or insert the CD or disk that contains 
the program into your desktop computer). 

1. Select Start > Settings > Control Panel > System > 
General on the Pegaso. Make a note of the 
information in the Processor field as shown at right. The processor type is required 
to determine file type compatibility.

2. Read the installation instructions, ReadMe files, or manual that comes with the 
program. Many programs provide installation instructions. 

• If you cannot find installation instructions for the program in the ReadMe file 
or manual, use ActiveSync Explore to copy the program file to the Program 
Files folder on your Pegaso.

• For more information on copying files using ActiveSync, refer to the ActiveSync 
online Help.

3. Connect your Pegaso and desktop computer. Refer to "Networks, Communica-
tions, and Connections", starting on page 4-1 to connect your Pegaso with your 
PC.

4. Double-click the *.exe or *.cab file.

5. Once the installation is complete, double-tap the program icon from the desktop, 
or select Programs > program icon to select it.

Refer to "Using ActiveSync to Add to the Start Menu" on page 3-7.
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Using Windows Explorer to Add to the Start Menu

1. Select Start > Programs > Windows Explorer, and select the directory where the appli-
cation or program is stored.

2. Select Cut from the Edit menu.

3. Open the Programs folder located in the Windows folder, select Paste from the 
pop-up menu. 

The program appears on the menu.

Using ActiveSync to Add to the Start Menu

1. Use the Explorer in ActiveSync on your desktop computer to explore the files on 
your Pegaso and locate the program. For more information on using ActiveSync, 
refer to "Installing & Setting Up Microsoft ActiveSync" on page 4-1, or see the 
ActiveSync online help on your unit.

2. Right-click on the program, then select Create Shortcut.

Move the shortcut to the Programs folder in the Windows folder. The shortcut 
appears on the menu.

Removing Programs
Only user-installed programs can be removed.

1. To remove a program, select Start > Settings > Con-
trol Panel > Remove Programs. 

2. Select the program you wish to remove from the 
list and tap Remove.
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Firmware Update Utility
The Pegaso is equipped with a field upgradeable firmware mechanism. Firmware 
updates for the Pegaso are uploaded to the Datalogic Mobile website (www.mobile.data-
logic.com). After you have downloaded the desired update, there are several ways you 
can update the firmware on the Pegaso. 

• Use the Falcon Management Utility (FMU) if you have multiple units to update. 
Refer to the FMU User’s Guide on the Product CD included with your Pegaso for 
more information.

• If FMU is not available or you have only a few units to update, use the Firmware 
Update Utility (FUU), described below, to install or update the firmware using an 
ActiveSync connection. Refer to "Installing & Setting Up Microsoft ActiveSync" 
on page 4-1 for more information.

FUU can also be used to restore the firmware onto a Pegaso that has become corrupted, 
such as would happen if the unit were powered down during an ActiveSync firmware 
update. See "Restoring Pegaso Firmware" on page 3-11.

The following sections provide procedures for the retrieval and installation of the most 
current firmware image onto a Pegaso.

Retrieving a Firmware Image Update
The following instructions use Internet Explorer to retrieve the most current firmware 
image.

1. Launch Internet Explorer on your PC and navigate to www.mobile.datalogic.com.

2. Navigate to the Downloads section of the website.

3. Select the product, desired language, and software updates. Click Go!

4. Select the file you want to download, then click Save and navigate to the location 
where you want to save the firmware files. 

5. Click Save again to begin copying the files to your local machine (or local network 
location).

Installing FUU on the Host PC
The Firmware Update Utility (FUU) provides administrators with a field upgrade 
mechanism. You must have Microsoft® ActiveSync already loaded and running on the 
host PC to use FUU. Refer to "Installing & Setting Up Microsoft ActiveSync" on page 4-1 
and "Using ActiveSync" on page 4-5 for more information about ActiveSync.

Prior to installing FUU, you must remove any previous versions of FUU installed on the 
host PC. 

http://www.mobile.datalogic.com
http://www.mobile.datalogic.com
http://www.mobile.datalogic.com


Firmware Update Utility

Product Reference Guide                            3-9

To install Datalogic Mobile’s Falcon® Firmware Update Utility, complete the following 
steps on the PC:

1. Insert the CD shipped with your Pegaso and click on the link to Firmware Update 
Utility. 

OR 
Go to the Datalogic Mobile website at www.mobile.datalogic.com and download the 
most current version of the Firmware Update Utility. Unzip the file, then double-click to 
run FUU_Setup.exe.

Click OK to continue once you have removed previous versions of FUU.

2. The Welcome to FUU Setup Program screen opens. 

• Please exit all Windows applications before running this setup. 

• Click Cancel to quit Setup and close any programs you have running. 

• Click Next to continue with the Setup program.

3. You must agree to accept the terms of the License Agreement by clicking on the 
appropriate button.

4. Follow the on-screen instructions to complete the installation.

http://www.mobile.datalogic.com
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Updating the Pegaso Firmware
After copying the firmware image to the host PC ("Retrieving a Firmware Image 
Update" on page 3-8) and installing FUU ("Installing FUU on the Host PC" on page 3-
8), you can upgrade the firmware on your Pegaso.

1. Go to Start > Programs > Firmware Update Utility > Firmware Update Utility.

2. Verify that ActiveSync is selected from the Communicate Using pull-down list.

3. Click browse (...) and navigate to the location where you saved the firmware file for 
your terminal.

4. Select the current *.img file and click Open.

5. Verify that the Pegaso is turned on. Insert the device into a powered dock con-
nected to the host computer.

6. Click Update Terminal on FUU on the host PC.

The following steps require that you have already established an ActiveSync connection 
between the host computer and the Pegaso. To establish an ActiveSync connection with 
the Pegaso, refer to "Installing & Setting Up Microsoft ActiveSync" on page 4-1 and 
"Using ActiveSync" on page 4-5, for more information on ActiveSync.
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7. FUU will compare the selected firmware image with the firmware already loaded on 
the Pegaso; if the images are different, FUU will proceed to update the firmware 
image on your Pegaso.

8. After the firmware of your Pegaso has been updated, you must perform a warm 
reset. Refer to the Pegaso Quick Reference Guide (QRG) for reset instructions.

Restoring Pegaso Firmware
If the firmware image on the Pegaso becomes corrupted, the unit will beep twice and 
show a blank screen when powered on. This can happen if a firmware update is aborted, 
such as during a power loss or if the Pegaso is removed from the Dock before comple-
tion of the procedure. 

To reinstall the firmware, complete the following steps:

1. On the PC, click Start > Programs > Firmware Update Utility > Firmware Update Utility.

2. Set Communicate Using to the communications port to which the dock is attached 
to (ActiveSync, USB, COM1 or COM2.)

3. Click browse (...) and navigate to the file location.

4. Select the current *.img file and click Open.

5. Verify that the Pegaso is turned on. Insert the unit into a powered dock connected 
to the host computer.

Please be patient and do not remove the Pegaso from the Dock during this procedure. 
The firmware image of the Pegaso can take as long as: 
• 6 minutes to download using a USB connection.
• 22 minutes to download using a serial connection with 115K baud rate. 
• 130 minutes to download using a serial connection with 19.2K baud rate. 
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6. Click Update Terminal on FUU on the host PC.

7. FUU will restore the firmware on the Pegaso as shown on page 3-10.

8. After the firmware has been restored, the Pegaso will automatically reset.

AutoStart 
The AutoStart program provides three functions: 

• Allows you to create a list of applications (with optional command line arguments) 
to run automatically prior to loading CAB files.

• Automatically reinstalls specified CAB files when the Falcon is Hard Reset.

• Allows you to create a list of applications (with optional command line arguments) 
to run automatically after loading CAB files.

AutoStart launches each time the Falcon is rebooted. AutoStart first runs 
PreAuto.ini (reference Table 3-3 for the location), executing each line with the spec-
ified command line arguments. It will take into account any AutoStart options at the 
begining of the line.

Upon a Cold Reset, AutoStart installs all the CAB files located in the AutoStart CAB 
folder. If the AutoStart CAB folder does not exist, no CAB files will be installed.

Table 3-2. AutoStart CAB folder location

AutoStart will then run the Autostart.ini (reference Table 3-3 for the location), 
executing each line with the specified command line arguments. It will take into 
account any AutoStart options at the beginning of the line.

Please be patient and do not remove the Pegaso from the Dock during this procedure. 
The firmware image of the Pegaso can take as long as: 
• 6 minutes to download using a USB connection.
• 22 minutes to download using a serial connection with 115K baud rate. 
• 130 minutes to download using a serial connection with 19.2K baud rate. 

Product Operating System Location

F4400 
Windows CE \FlashFX Disk
Windows Mobile \FlashDisk
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Table 3-3. PreAuto.ini and Autostart.ini location

Installing CAB files
Copy any CAB files you want to install into the AutoStart CAB folder. These CAB files 
will then be automatically installed in alphabetical order the next time you start the 
device.

How AutoStart Uses Wceload

CAB files are installed by AutoStart using the Wceload.exe application. Table 3-4 on 
page 3-13 shows available command line options:

Table 3-4. AutoStart command line options

Please refer to the Microsoft documentation on your device for further details on Wce-
load.exe.

Sample: 

\Windows\Wceload.exe /delete 1 /noui /silent “\Flash-
Disk\CAB\<cab file>”

Interactive CAB Install
If the CAB installer requires user interaction that must be performed during the 
AutoStart CAB installation process, you can specify a special file name to disable the 
silent mode installation. If this mode is specified, the CAB file will be installed with 
Wceload without any command line arguments specified.

An example of what AutoStart would execute is:
\Windows\Wceload.exe <cab file>

To force this mode of installation via AutoStart, rename the CAB file to include a ‘_’ 
character before the “.cab” extension of the file.

Product Operating System Location

F4400 
Windows CE \FlashFX Disk
Windows Mobile \FlashDisk

If you intend to create highly interactive installers, you should either install the CABs 
manually or review the section on “Interactive CAB Install” in this chapter.

CAUTION

In certain environments, CAB files will be deleted after execution. To prevent the CAB file 
from being deleted, write protect the file before copying the file onto the device.

Option Description

/noui

Specifies that you will not be prompted for any input during the instal-
lation. If the CAB file is signed, any responses will automatically be 
answered ‘Yes.’ If the CAB is unsigned, then any responses will be 
answered ‘No.’

/silent Suppresses dialog boxes during the installation.
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Example:

“File.cab” should be renamed “File_.cab” to force AutoStart to not install the 
CAB in silent mode. This specially-named CAB file should be placed in the AutoStart 
folder with other CAB files intended for installation on the next reboot.

Autostart.ini

Autostart.ini and PreAuto.ini are text files that AutoStart will run upon star-
tup of the Falcon, and after any CAB files are installed. This file should be placed in the 
AutoStart folder. AutoStart will run the Autostart.ini file on each reboot of the 
device.

Line Formatting
Each line of the Autostart.ini can consist of Autostart options, an executable, and 
any command line arguments.
< Autostart option(s)> <full path to executable> <command line 
arguments>

Sample: 

- \windows\pword.exe \file.doc

Table 3-5 breaks down the sample Autostart.ini line.

Table 3-5. Autostart.ini line formatting

Spaces must be placed between each component of the line in the Autostart.ini. 

If the executable path is in a folder that contains spaces in the name, quotes are required 
to distinguish what the actual executable name is. The following is an example of this:

“\Program Files\ScannerApp.exe” /run (valid)

\Program Files\ScannerApp.exe /run (invalid)

The second line is an invalid line because there is no way to distinguish the executable 
from the argument.

AutoStart Options
Table 3-6 shows options you can use when writing a line in the Autostart.ini or 
PreAuto.ini file.

Autoexec.ini, which uses AutoCE on some older models, has been deprecated. These 
files should be renamed to Autostart.ini and reformatted as described in "AutoStart" on 
page 3-12.

In the following section, all references to AutoStart.ini also pertain to PreAuto.ini.

Autostart 
option(s) Full path to executable Command line arguments

- \windows\pword.exe \file.doc
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Table 3-6. Options for Autostart.ini and PreAuto.ini

Cold Reset Only:  This will cause the line to execute only after a Cold Reset.

Combining Options
Autostart options can be combined together as shown in the following sample:
?- \Windows\Pword.exe

This line would:

• Request confirmation before executing the line. The next line would not be pro-
cessed before the confirmation is answered.

• Run the next line without waiting on the current line to complete execution. 

Query Option
The query option is intended for use when debugging the autostart.ini. When a 
line with this option is executed, the following dialog will appear with the specified exe-
cutable and command line arguments. The populated fields shown in the AutoStart 
Execute Query are described in Table 3-7 on page 3-16.

AutoStart Execute Query

Description Character Comments

Comment: This line will not be 
executed.

‘#’ OR ‘ ‘ 
(space)

This may only be used as the 
first character of the line. If the 
comment option is specified in 
the options elsewhere, it is 
ignored.

Do not wait on line completion: 
This will cause the line to exe-
cute and immediately move 
onto the next line.

‘-’

Query: Request user confirma-
tion when running the execut-
able. 

‘?’

This will halt parsing the 
Autostart.ini until the confirma-
tion is answered. This is 
intended for debugging the 
Autostart.ini file.

Execute only on Cold Reset ‘!’

An empty line will be treated as a comment line.
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Table 3-7. AutoStart Query options

Parentheses are used to surround the given field and make it very clear what the value of 
the field is.

Table 3-8 describes the results of each choice:

Table 3-8. AutoStart Query actions 

Autostart.ini Samples
Table 3-9 on page 3-16 is a collection of sample Autostart.ini lines.

Table 3-9. Sample Autostart.ini lines

Field Description

Line Number This is the line number in the script being executed.
Exe The executable as parsed by AutoStart.
Args The argument as parsed by AutoStart.

The fields may be broken up into multiple lines (as shown in the example) due to limited 
space in the dialog.

Button Action

Yes The current line will execute.

No
The current line will not execute. AutoStart will continue pars-
ing the Autostart.ini.

Cancel
The current line will not execute and AutoStart will discon-
tinue parsing the Autostart.ini.

Line Description

? \windows\wceload.exe “\My 
Documents\FDU.cab”

This will confirm the execution of \Windows\wceload.exe with 
specified argument “\My Documents\FDU.cab”

\Program Files\App.exe (invalid) This will execute \Program with the argument 
Files\App.exe.

\Program Files\App.exe /run
(invalid) This will execute \Program with the argument 
Files\App.exe /run.

“\Program Files\App.exe” /
run

This will execute the program \Program Files\App.exe with the 
argument /run.

?- \Windows\Pword.exe This will confirm the execution of \Windows\Pword.exe. If the exe-
cution is confirmed, AutoStart will immediately process the next line.

!”\Program Files\App.exe” /run
This will execute the program \Program Files\App.exe with the 
argument /run ONLY after a Cold Reset.
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Chapter 4
Networks, Communications, and 

Connections

Overview
This section contains the following topics:

• "Installing & Setting Up Microsoft ActiveSync" starting on page 4-1.
• "Installing Microsoft ActiveSync" on page 4-1.
• "Setting up ActiveSync" on page 4-3.

• "Installing the USB Driver" on page 4-4.

• "Using ActiveSync" starting on page 4-5.

• "Networking" starting on page 4-8.
• "Setting up the Network ID" starting on page 4-8.
• "Network and Dialup Connections" starting on page 4-8.
• "Network Setup: Remote ActiveSync" starting on page 4-9.

• "SNMP" starting on page 4-9.

Installing & Setting Up Microsoft ActiveSync
This section provides instructions on setting up the Host PC so that the PC can com-
municate with the Pegaso and the dock. 

Installing Microsoft ActiveSync
Microsoft® ActiveSync is a file transfer tool used to synchronize the files on a PC with 
the files on your Pegaso. The device comes from the factory with ActiveSync loaded. If 
you have ActiveSync already installed on your PC, make sure that you have v3.7.1 or 
higher.

The screen shots in the manual were taken and the procedures were written using Win-
dows® XP. If you are using a different Windows operating system, appearances and pro-
cedures may be slightly different.

Important! You must disconnect any other PDAs, PDTs, or Pegasos using USB Active-
Sync from the Host PC prior to connecting the Pegaso or the Host PC and Microsoft 
ActiveSync may not recognize the new device.
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To install Microsoft® ActiveSync on the PC, complete the following steps:

1. Go to the Microsoft® Windows website at 
http://www.microsoft.com/downloads/.

2. Use the Product/Technology pull-down list to search on “ActiveSync” for the most 
current version. 

3. Download the current version of ActiveSync from the Microsoft website.

4. Install the most current version of Microsoft® ActiveSync on the host PC (refer to 
Figure 4-1).

Figure 4-1. Microsoft ActiveSync Installer 

Figure 4-2. Microsoft ActiveSync Installer 

http://www.microsoft.com/downloads/
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5. Click Next to continue the installation. Click Cancel to cancel the installation of 
ActiveSync.

Figure 4-3. Microsoft ActiveSync Installer 

6. Reboot your PC.

7. You have completed installing ActiveSync.

Setting up ActiveSync

1. Open ActiveSync from the Host PC.

2. Connect the Pegaso to the Host PC via a dock or USB/Serial cable. 

3. Verify that the Pegaso is turned on.

4. Within a minute, the ActiveSync window should appear, attempting to connect to 
a new device. 

Figure 4-4. Microsoft ActiveSync dialog

5. If ActiveSync does not connect within two minutes, try the following:
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• Double-click and open ActiveSync from the Host PC’s System Tray if it is not 
already open.

• Remove the Pegaso from the dock and then reinsert it into the dock or discon-
nect the cable from the Host PC and reconnect it. 

• Select File > Get Connected for ActiveSync to look for a mobile device.

• Go to File > Connection Settings and make sure that your Connection Settings 
dialog show the same selections as that in Figure 4-5 below if you have a USB 
connection. If you have a serial connection, select the correct COM port from 
the pull-down list.

Figure 4-5. Connection Settings 

6. You have completed setting up ActiveSync. Proceed to "Installing the USB 
Driver", below, to install the USB driver.

Installing the USB Driver
In order for the Host PC to communicate with the Pegaso, you must install the USB 
driver file from the CD that came with the Pegaso, or download it from the Datalogic 
website at www.mobile.datalogic.com.

Microsoft ActiveSync must be installed on your computer before proceeding. See "Set-
ting up ActiveSync" on page 4-3.

Important! Install the USB driver PRIOR to connecting the Pegaso to the host PC.

http://www.psc.com
http://www.psc.com
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1. Copy the USB driver file from your Pegaso CD or the Datalogic website to the 
following location on your computer:  
C:\Program Files\Microsoft ActiveSync\Drivers.

2. Connect the USB or Serial cable to Pegaso or place the unit in the dock.

3. Connect the USB or Serial cable to a Host PC.

4. Follow the directions onscreen. The specified source directory will be the one 
identified in step 1.

5. You are now ready to use ActiveSync.

Using ActiveSync
Use ActiveSync to transfer and synchronize (share) files between the Pegaso and the 
Host PC. 

Setting up a Partnership
During the Microsoft ActiveSync installation, you were prompted to create a partner-
ship with your mobile device. When you set up a partnership, you select synchroniza-
tion and file conversion settings, which are contained in a file on your desktop 
computer. This file enables your desktop computer to recognize your device. Only 
devices that have a partnership with a desktop computer can synchronize information 
between the two computers.

Partnerships are stored in ActiveSync and have the same name as the corresponding 
device. Your desktop computer can set up partnerships with many different mobile 
devices, but the Pegaso can have partnerships with only two computers. For more infor-
mation on partnerships, please refer to your Microsoft ActiveSync documentation or 
help file.

Transferring Files
To transfer files, complete the following steps on the host PC:

1. Select Start > Programs > Microsoft ActiveSync.

2. Double-click on the ActiveSync icon in the System Tool Tray.

3. After you have established a connection with your Pegaso, tap Explore at the top of 
the ActiveSync window (or select Explore from the File menu). Refer to Figure 4-6 
on page 4-6.

Important! You must disconnect any other PDAs, PDTs, or Pegasos using USB Active-
Sync from the Host PC prior to connecting the Pegaso, or the Host PC and Microsoft 
ActiveSync may not recognize the new device.
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Figure 4-6. ActiveSync Dialog 

4. Navigate to the target directory (folder) on your portable.

Figure 4-7. Exploring the Mobile Device 

5. Copy the desired file by using the Copy/Paste method or dragging and dropping 
the desired file(s) into the directory (folder).

Depending on the file type, ActiveSync may convert the file into a format appropriate 
for the Windows CE device. 

File Synchronizing using ActiveSync
ActiveSync file synchronization requires an ActiveSync partnership between the Pegaso 
and the Host PC. Refer to "Setting up a Partnership" on page 4-5. 

1. Select the controls in the synchronization configuration for the Pegaso partner-
ship. Refer to Figure 4-8 on page 4-7.

2. Select Tools > Options from the ActiveSync command bar to configure the synchro-
nization options.
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Figure 4-8. File Synchronization Options

3. Place the file to be synchronized in the Synchronization folder created in your 
My Documents directory (defaults to the desktop). Refer to Figure 4-7 on page 
4-6. 

During the ActiveSync connection, all files in the Synchronization folder will be 
synchronized with (copied to) the \My Documents directory on the Pegaso.

Figure 4-9. Select Synchronization Settings 
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Networking

Setting up the Network ID
To set up your Network ID (configure the Windows user settings, such as the user 
name, password, and domain), complete the following steps on the Pegaso: 

1. Go to Start > Settings > Control Panel > Owner.

2. Select the Network ID tab on the Owner Properties dialog box.

3. Enter your User Name, Password, and Domain on the Network ID tab.

4. Select OK on the command bar to save your network ID information.

Access basic network connection information by double-tapping on the Network icon in 
the system tray. Tap Details to show more information.

The Network Icon
The network icon in the system tray indicates if the network is currently connected or 
not.

Figure 4-10. The Network Icon 

Network and Dialup Connections 
Radio Card settings will vary depending on the type of radio card you are using. For 
assistance configuring the Pegaso for your RF network, reference Remote Connections 
in the online help on your unit. Reference the documentation for your radio card type 
for further information.

 11:57 AM 

System Tray 

Network 
Connection Icon 

Connected Not Connected 
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Network Setup: Remote ActiveSync
To execute a Remote ActiveSync, complete the following steps:

1. Go to Start > Programs > Communication > Netlink.

2. Select the target host to which you wish to connect in the Connect To field.

3. Tap Connect.

4. A network ActiveSync connection will be established.

Network functions and operations work the same when using the Dock.

SNMP
SNMP (Simple Network Management Protocol) is the standard protocol for managing 
devices on a network. The Falcon Management Utility (FMU) makes use of SNMP to 
send and receive configuration information to the Datalogic terminals. Since the net-
worked terminals are constantly running SNMP, this allows FMU to interface with the 
terminal at any time, without requiring user intervention on the terminal. 

With SNMP running on the terminal, other SNMP based network management tools 
such as HP Openview® and CastleRock SNMPpc® may also be used to interface with 
the terminals. To support this capability, Datalogic has released the Management Infor-
mation Base (MIB) for the Datalogic Windows-based terminals. The MIB is used by 
the management tools to allow them to better support the configuration values provided 
on the terminals, such as scanner controls and terminal type information.

You must have established an ActiveSync partnership with a host before you can use 
Remote ActiveSync to connect to it. To establish an ActiveSync connection with the 
Pegaso, refer to "Installing & Setting Up Microsoft ActiveSync" on page 4-1. 

The MIB is available at www.mobile.datalogic.com.

For more information on SNMP, refer to "SNMP Interface", or go to: 
http://www.microsoft.com.

http://www.microsoft.com/downloads/results.aspx?sortCriteria=date&OSID=&productID=&CategoryID=&freetext=ActiveSync&DisplayLang=en&DisplayEnglishAlso=
http://www.mobile.datalogic.com
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NOTES
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Appendix A
Accessories

Overview 
This appendix covers the following topics:

"Power Supplies" on page A-2.

• "Powered USB Cable & Power Supply"

• "Battery Pack"

• "Single Slot Dock" 

• "Four-Slot Charge Dock"

• "Four-Slot Ethernet Dock"

• "Four-Slot Battery Charger"  

• "Car Charging Adapter" 

"Ethernet Module" on page A-7

"Modem Module" on page A-6

"Handstrap" on page A-7

"Handle" on page A-8

"Belt Clip" on page A-10 

"Screen Protector" on page A-12

Contact your Datalogic reseller for accessories and supplies for the Pegaso; go to the 
Datalogic website for the most current information.
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Power Supplies

Powered USB Cable & Power Supply

Figure A-1. Power Supply and Powered USB Cable

Battery Pack
The Battery Pack and the Battery Door are integrated and are not sold separately. The 
Pegaso is available with either a standard or high-capacity battery.

To remove the Battery Pack on the Pegaso, complete the following steps:

1. While pushing the Battery Latch (shown in Figure A-2), lift out the Battery Pack, 
top first.

2. To replace, seat the bottom end first, then click the Battery Pack into place.

Use only the correct battery chargers and docks with this Windows CE Pegaso. The tech-
nology used for these models is incompatible with other Datalogic chargers and docks. 
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Figure A-2. Battery Pack

Single Slot Dock

Figure A-3. Single Slot Dock

Battery Pack

Seat this
end first

Battery Latch
(push in to release)

Battery Pack in Charger

USB/Serial Connector Pull Upward to Remove

LEDs
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Four-Slot Charge Dock
The Four-Slot Charging Dock provides the ability to charge up to four Pegasos and four 
spare batteries simultaneously.

Figure A-4. Four-Slot Charge Dock

Four-Slot Ethernet Dock
Like the Four-Slot Charging Dock, the Four-Slot Ethernet Dock provides the ability to 
charge four Pegaso and four spare batteries simultaneously. In addition, the built-in 
Ethernet hub gives all the docks a unique Ethernet address accessible through one phys-
ical 802.3 CAT5 connection. See "Ethernet Module"on page A-7 for more information 
on setting up an Ethernet connection.

Use when you want to connect to an Ethernet network, or for batch units to synchro-
nize without the need for wireless technology. 

There are two LEDs; one for 10/100 Mbps link and the other for Tx/Rx.

Figure A-5. Four-Slot Ethernet Dock
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Four-Slot Battery Charger
Charge up to four spare battery packs simultaneously with the Four-Slot Battery 
Charger.

Figure A-6. Four-Slot Battery Charger 

Car Charging Adapter
A Car Charging Adapter is available for the Pegaso. To attach, just plug the adapter into 
the connector on the bottom of the unit, and tighten the thumb screws to secure it. 

Figure A-7. Car Charging Adapter

LEDs
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Modem Module
An optional Modem Module allows you to use the Pegaso to dial a server in a remote 
office.

Features:
• V.92/56K data rate backward compatible with 

lower speeds

• V.44 and V.42 bits data compression

• V.42 error correction

• AT command compatible

• U. S. Caller ID reporting

• FastPOS (V.29) and V.22vis Fast Connect

• V.80 Synchronous Access

• Built-in  speaker

• Easy to use

To connect:

1. Remove the Pegaso from the dock and detach power from the dock.

2. Plug the modem module into the dock, and then plug the phone cable into 
modem.

3. Replace the Pegaso into the dock and restore power.

4. Select Start > Settings > Network and Dial-up Connections to open dial-up network-
ing. 

5. Tap Make New Connection to create a new connection.

6. Type a name for the connection, and tap the radio button to select Direct Connec-
tion. Tap Next.

7. Select Hayes Compatible Modem on Com1 as the device. 
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8. Click on TCP/IP Settings and Security Settings and fill in as needed to connect to 
the remote server. Check with your network administrator for settings. Tap Finish 
when complete.

9. Double tap the newly named connection.

10. Fill in the necessary username, password, and domain.

11. Tap Connect to continue.

A PPP connection has now been created. TCP/IP network communications can com-
mence.

Ethernet Module
The optional Ethernet Module allows the Pegaso to connect to an Ethernet network. 
There are two LEDs; one for 10/100 Mbps link and the other for Tx/Rx. The commu-
nications rate is 10/100Mbps – Auto-negotiate.

 To Connect:

1. Remove the Pegaso from the dock, and 
unplug the power from the Dock.

2. Plug the ethernet module into the Dock, then 
plug a CAT5 cable into the Ethernet module.

3. Replace the Pegaso into the Dock, and restore 
power to the Dock. 

A network icon will be displayed in the system tray. 
All normal network activities can now take place.

Handstrap

Removing the Handstrap
An elastic Handstrap is included with the Pegaso. To remove the Handstrap, complete 
the following steps. Reference Figure A-8 while performing these actions.

1. Grasp the lower handstrap attachment and pull to slide out from the unit.

2. Using a Phillips screwdriver, remove the two screws securing the upper handstrap 
attachment to the unit.

It is not necessary to remove the Handstrap to install the Handle or the Belt Clip.
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Figure A-8. Removing/Replacing the Handstrap 

Installing the Handstrap
To install a Handstrap on the Pegaso, follow the steps described below.

1. Feed the strap end of the handstrap down through the Back Enclosure Handstrap 
Holder slot as shown in Figure A-8 and loop it up to engage the closure area at the 
desired position.

2. Attach the Upper Handstrap Assembly to the unit using the two Phillips screws.

Handle
The Pegaso is available with an attachable handle 
which provides an additional trigger for scanning. 
When you remove the handle, you lose the ability 
to press the trigger on the handle and must use the 
<Scan> key on the keypad or Scan triggers on the 
Pegaso instead.

To install a handle, refer to the following sections. 
Reverse the instructions to remove  the handle.

Handstrap

Back Enclosure
Handstrap Holder

Closure AreaUpper
Handstrap
Assembly

The Handstrap can be left on when installing the 
Handle.
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Installing a Handle on the Pegaso
The handle may be installed without removing the handstrap. To install the handle on 
the Pegaso, complete the following steps:

1. Align the “ears” on the handle with the corresponding holes on the underside of 
the Pegaso and slide them into place.

2. Seat the top of the Handle against the Pegaso and turn the quarter-turn fastener to 
secure the Handle to the unit.

 The trigger is automatically activated and available. Press to initiate scanning

Ears

Handle
Locked

Position

Unlocked
Position

1/4 Turn Latch
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Belt Clip

The Belt Clip comes with two separate pieces: 
one that attaches to the Pegaso, and one that 
attaches to your belt. 

To install the Belt Clip on the unit, complete 
the following steps:

1. Turn the Pegaso face-down and ensure 
that power is off.

2. Orient the Belt Clip on the underside of 
the Pegaso.

3. Align the “ears” on the inside of the Belt Clip with the corresponding holes on the 
underside of the Pegaso and slide them into place. 

4. Push the top of the Belt Clip against the Pegaso and turn the quarter-turn fastener 
to secure it.

The Handstrap can be left on when installing the Belt Clip.

Ears
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Figure A-9. Installing the Belt Clip

Attaching to a Belt
To attach the Pegaso to a belt, snap the Belt Attachment onto your Belt. Slide the Pegaso 
onto the Belt Attachment sideways, then rotate to an upright position to secure it into 
place, as shown in Figure A-10.

Figure A-10. Attaching to a Belt

Belt
ClipLocked

Position

Unlocked
Position1/4 Turn Latch
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Screen Protector
A Screen Protector is available for the Pegaso. Use the following instructions to attach a 
Screen Protector.

1. Gently but thoroughly clean the touchscreen using a lens 
cloth or other soft, lint-free cloth. If necessary, dampen 
the cloth with a mild cleaning solution, such as liquid 
hand soap and water. Thoroughly dry the area after 
cleaning, and ensure it is lint-free.

2. Remove the Screen Protector from its packaging 
and, while holding it by the edges, pull the tab to 
begin peeling the backing from about one inch of 
the adhesive side. Fold the backing down as you go.

3. Orient the Screen Protector with its adhesive side towards the screen and CARE-
FULLY align its top edge and corners with the screen recess, as shown in 
Figure A-11A. If alignment is not perfect, gently lift up and start again.

4. Continue to peel the backing while slowly seating the protector in place. Use a 
credit card (if available) or similar soft-edged object to evenly smooth the Screen 
Protector and push out any bubbles between the surfaces. Reference Figure A-11B.

Figure A-11. Applying a Screen Protector to the Pegaso

You may find it helpful to have the unit firmly seated in its dock while performing these 
procedures. Another useful tip is to have a credit card handy to assist in smoothing the 
Screen Protector in place.

CAUTION

Never use corrosive or abrasive cleaners or cloths on the 
Pegaso.

Tab

CAUTION

DO NOT touch the adhesive area, as this could leave a fingerprint when installed.

A B
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Appendix B
Falcon® Desktop Utility 

for Windows® CE 

Overview
Falcon® Desktop Utility (FDU) allows Datalogic Pegaso™ Windows® administrators to 
configure Pegaso Windows® CE devices to control individual user access. This includes: 

• Prevent users from changing Pegaso OS settings.

• Define keys to access specific functionality/programs. 

• Use Application Selector to replace desktop with a selection of authorized applica-
tions.

• Internet Explorer access restriction, configuration and customized recovery mecha-
nisms.

This section covers the following information:

• "Falcon Desktop Utility" on page B-2

• "Administrative Options" on page B-3.

• "Setting Hot Keys" on page B-5.

• "Internet Explorer Configuration" on page B-8.

• "Modifying Windows Controls" on page B-9 

• "Add Application" on page B-11.
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Falcon Desktop Utility
To open the FDU for the first time, select Start > Settings > Falcon Config. 

Figure B-1. Accessing FDU 

These options are available from all screens:

Table B-1. Options Available on all Screens

Command Description

OK
Tap OK to apply the settings and modifications you have made in the 
FDU tabs. OK saves every modification.

X
Tap X to cancel the settings and modifications you have made in the 
FDU tabs. X cancels all modifications you have made in FDU.
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Administrative Options
When you open the Admin control panel, the FMU tab will open. Select the Admin tab to 
set up FDU.

Figure B-2. Setting a Password/Admin Tab Fields 

Table B-2. Setting a Password/ Admin Tab Fields

Command Description

Enable Falcon 
Desktop 

Select/tap this checkbox to activate the FDU functions such as 
Hot Key assignments, IE Restrictions, Windows Settings, and the 
authorized application menu.

Enter Password

Enter a password in the text box. This allows the user to specify a 
password when this utility is launched. By default there is no 
password. A password can consist of all standard keyboard char-
acters.

Re-Enter Pass-
word 

Carefully re-enter the password in the second text box. 

Set Password 
Select/tap Set Password to enable the password. 

To change or remove the password, enter a new value, re-enter 
the new value, and select/tap Set Password.

Restore 
Defaults 

Select/tap Restore Defaults to reset the default values of all the 
functions on all the tabs. After you select this option, you will 
receive a prompt to verify this selection.
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Setting a Password
To set a password:

1. Enter a password in the field. This allows the user to specify a password when this 
utility is launched. By default there is no password set.

2. Re-enter the password in the second field.

3. Select/tap Set Password to enable the password.

4. Select/tap OK close the Set Password Confirmation dialog.

Changing a Password
To change to a new password:

1. Enter a new value in the Enter Password field.

2. Re-enter the new value in the Re-enter Password field.

3. Select/tap Set Password.

Removing a Password
To remove a password:

1. Enter blanks in both Password fields.

2. Select/tap Set Password.

Password Request Dialog Box
Once the password is set, the next time you open the Falcon Desktop Utility, the FDU Pass-
word dialog box opens. 

This dialog box will only open if a password was defined.

Be sure to record the Password for future reference. 

You must select/tap Set Password prior to exiting FDU in order to store and 
activate your new password. It is not necessary to select Enable Falcon 
Desktop.

CAUTION

If you select/tap Restore Defaults it will remove all custom settings and 
restore all the factory default settings, except a previously set password.
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Figure B-3. Setting a Password 

Table B-3. Setting a Password Dialog

Complete the FDU Config dialog: 

1. Type in your password using either the keypad on the unit, or using the stylus on 
the soft input panel (SIP).  
If you enter an incorrect password, the system will prompt you to input the correct 
one.

2. Select/tap OK to verify the password. Or tap X to cancel.

Setting Hot Keys 
You can use Hot Keys (HKeys) Tab to associate specific keys, such as <F1>-<F10>, with spe-
cific applications. You can also create a new Hot Key combinations ("Adding a New Hot Key" on 
page B-7). Select the HKeys tab to access these options. 

For example, you could set <F2> to launch a sample application like: 

\Windows\pword.exe. 

Command Description

Enter Password
Enter your password using the keypad, or using the stylus on the 
soft input panel (SIP) in the text box. 

OK Select/tap OK to accept the password.

X Select/tap X to cancel the request to start the FDU.
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Figure B-4. Hot Keys Tab 

Table B-4. Hot Keys Tab Fields

The <F6> is the key initially assigned to FDU Admin:

If you wish to assign this key to a different function, you must first select an unassigned 
Hot Key and assign it to the Action - FDU Admin. You can then go back and reassign the 
FKey to something else.

Command Description

Hot Key 
This pull-down list displays the available function keys to define. 
Select the desired one from the list.

New 
Select/tap to specify a new Hot Key, not on the Hot Key list. This 
opens a new dialog, shown on page B-7.

Delete
Tap to delete the selected Hot Key. You can only delete the Hot 
Keys you have added. You cannot delete <F1> -<F10>.

Associated 
Function 

This pull-down list displays the available functions. Select either 
Application or Action.

Application Displays path to the selected application.

Browse Select/tap  to browse for application files. You can associate an 
executable program with the specified Hot Key. 

Arguments 
Type the command-line arguments that are needed for the specified 
application. This option is only available when Application is 
selected in the Associated Function pull-down list. 

Action 

Specify an action to associate with a Hot Key. This list includes: 
SIP, toggle Taskbar, FDU Admin, and Applica-
tion Switcher. This option is only available when Action 
is selected in the Associated Function pull-down list. 
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Table B-5. Pegaso Hot Keys Available

Adding a New Hot Key
When you select New on the HKeys tab, this opens the Add New Hot Key dialog box. 

To define a new Hot Key, complete the following steps:

1. Enter the key combination to define a new Hot Key in the Enter Key textbox.

2. The Note displays important information indicating Hot Keys that should not be 
used.

Figure B-5. Add a New Hot Key Dialog

Table B-6. Adding a New Hot Key Dialog

Pegaso

19-key models

Numeric

F1-F10

Alpha keys

Side/top triggers

The administrator is responsible for verifying that these keys don’t override existing func-
tions. To prevent FDU Hot Keys from overriding existing application keys, select “No 
Action” in the Action combo box.

Command Description

Enter Key
Enter the desired key combination in this text box to define a Hot 
Key.

OK Select/tap OK to add the specified Hot Key.

X Select/tap X to cancel the specified Hot Key.
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3. Select/tap OK to save the New Hot Key. If you select/tap X, the key will not be saved.

Internet Explorer Configuration 
Tap the IE (Internet Explorer) tab to access the IE Configuration option. Use the IE Error 
Redirection option to provide customized recovery from common IE errors. When an 
error occurs, the browser can redirect access to a specified error page with instructions 
on how to recover from the problem.

Figure B-6. IE Configuration Tab / IE Window Features

Table B-7. IE Tab Fields 

Make sure you do not attempt to add a Hot Key that is already defined.

It is possible for the keyboard wedge to activate assigned Hot Keys using alphanumeric 
characters. Bar codes containing characters associated with assigned Hot Keys will trig-
ger the action or application assigned to that Hot Key.

Command Description

Error Type 

The Error Types pull-down list displays available IE Error 
Types: 

(400) Invalid Syntax, (403) Request Forbidden, (404) Object 
Not Found, (406) No Response Format, (410) Page Doesn't 
Exist, (500) Internal Server Error, (501) Server Can't Do That, 
Generic Error, Server Is Busy, Couldn't Find Server, URL Syn-
tax Error, Request Cancelled, Not Available Offline

Error Page 
Edit this textbox to associate a website or html file with the 
specified error.

IE Address Bar IE Tool 
IE Menu Bar

IE Status Bar
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Internet Options
Tap Internet Options on the IE tab to open the Windows CE Internet Options control 
panel. Customize these settings as necessary.

Modifying Windows Controls 
Select/tap the Win (Windows Controls) tab to access the Windows Controls option. Use 
Windows controls to allow or restrict access to Windows system functions.

You can disable normal Windows functions such as the desktop and taskbar, leaving 
nothing but a blank workspace. This allows applications to be run on the full screen and 
prevents users from accidental or unauthorized use of the taskbar, Internet Explorer, and 
any other resident applications.

Assign as Default 
Select/tap to set a specified error page as the default. A confir-
mation dialog opens to ask if the default error page applies to 
all errors. 

Browse Select/tap  to browse for files.

Show Address 
Bar 

Select/tap this check box to show the IE address bar.

Show Tool Bar Select/tap this check box to show the IE toolbar.

Show Status Bar Select/tap this check box to show the IE status bar.

Show Menu Bar Select/tap this check box to show the IE menu bar.

Command Description

The Internet Options control panel applet is part of the Microsoft® Windows® CE operat-
ing system. 

For more information on the Windows CE operating system, please refer to the Microsoft 
website at http://www.microsoft.com.

CAUTION

The FDU allows you to cancel prior to applying your changes. However, any settings mod-
ified in the Internet Options control panel applet through the FDU interface will be applied 
even if you later cancel the your modifications in the FDU.

http://www.microsoft.com
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Figure B-7. Windows CE Desktop and Win Tab

Table B-8. Win Tab Fields

Command Description

Show Taskbar 
Select/tap Show Taskbar to specify that the taskbar is 
shown or hidden.

Taskbar Enabled 
Select/tap Taskbar Enabled to specify whether the taskbar 
is accessible. This option is only available when the Show 
Taskbar is checked.

Start Menu Enabled 
Select/tap Start Menu Enabled to specify whether the Start 
menu is accessible or not. This option is only available when 
both Show Taskbar and Task Bar Enabled are checked.

Windows CE Desk-
top Enabled 

Select/tap Windows CE Desktop Enabled to specify that 
the desktop icons are accessible or not.

WinCE  
Desktop

Start Menu

Taskbar
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Application Selector 
Use the Application Selector (AppSelect Tab) function to edit, add, or delete applications 
for the application selector. 

Figure B-8. AppSelect Tab

Table B-9. AppSelect Tab Fields

Add Application
The Add Application dialog opens when you tap either New or Edit. 

From the Add Application dialog the administrator can configure and/or add/change an a 
new application entry in the list.

Applications with the Run Application at Startup option enabled will start automatically 
when the Application Selector starts up.

Command Description

Enable Applica-
tion Selector 

Select/tap Enable Application Selector to enable/disabled 
the application selector. When this is enabled, the Application 
Selector replaces the desktop and allows only authorized use 
of applications.

Authorized Appli-
cations 

This is a list of applications that the user may access.

New Select/tap New to create a new application entry.

Edit Select/tap Edit to edit the selected entry.

Delete Select/tap Delete to delete the selected entry.

Up/Down
Select/tap Up/Down to move an entry up or down in the list-
view.
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Figure B-9. Add Application Dialog 

Table B-10. Add Application Dialog 

Command Description

Application Title 
Type the name of the application in this textbox in the way you 
wish it to appear for the user.

Executable Displays the path for the executable file which you want to run. 

Browse Select/tap  to browse for the desired executable file. The 
results of this search are placed in the Executable textbox.

Arguments
Type any command line arguments to be used when an applica-
tion is executed.

Icon File Displays the path/link to the desired icon file. 

Browse Select/tap  to browse for the desired icon file. The results of 
this search are placed in the Icon File textbox.

Run Application 
at Startup 

Select/tap this box to force this application to auto start when the 
Application Selector starts up. Applications will be started in the 
order listed in the authorized application list.

Delay
Enter a delay duration in seconds in the combo box. 

This option delays auto start of application(s) to allow drivers to 
load prior to starting applications

OK Select/tap OK to add/save changes.

X Select/tap X to cancel the creation of this entry.
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Application Selector
The administrator can choose for the user to have access to the desktop or not. The 
Application Selector can replace the desktop and limit the user to the specified list of 
applications. 

Figure B-10. Application Selector 

The user can select/tap the desired application.

The administrator can customize this list as shown in "Application Selector" on 
page B-11.

Application Switcher User Interface
The application switcher provides the same functionality as the standard Windows® 
Alt+Tab function. This allows the user to cycle through the various open applications. 

The application switcher is activated via an assigned 
Action key specified in the Hot Key tab. (Refer to "Set-
ting Hot Keys" on page B-5.) When the assigned Hot 
Key is pressed, the dialog shown to the right will be 
displayed. 

The application switcher can only be assigned to a sin-
gle Hot Key, not a Hot Key with modifier keys. For 
instance, <Shift>+<F3> cannot be assigned to the task 
switcher action, but <F3> can be.

Press the Hot Key assigned to open the application 
switcher. Press the assigned Hot Key to cycle through 
the running applications when the dialog is open. 
Press <Enter> to switch to the selected application or 
<Esc> to close the application switcher.

The <Esc> key can be used to close the Application Switcher.
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Appendix C
Configuring the Web Server

Overview
The Web Server can perform several different actions, including generating a web page 
containing statistics relating to performance of the mobile computer. The Web Server 
can also be used for creating an interface for interaction with the Terminal to configure 
system behavior.

This section contains the following topics on configuring the Web Server:

• "Enabling the Web Server" below.

• "Testing the Web Server" on page C-3.

• "Launching the Network Administration Page" on page C-4.

• "Web Server Registry Settings" on page C-4.

• "Creating and Using an ISAPI Service" on page C-5.

Enabling the Web Server
By default the Web Server is disabled. The following demonstrates how to enable the 
Web Server: 

1. On the Pegaso, either through a CE-based registry editor or using the Remote 
Tools RemoteRegEdit included with eVC++ 4.0, modify the following registry 
entry:
[HKEY_LOCAL_MACHINE\COMM\HTTPD]

"Enabled"=dword:1

2. In a Command Prompt window on the Terminal, type the following:
\> services list

This will display a list of loaded and services and their state. 

3. If the service HTP0: is not listed, then type the following to load the HTTP Web 
Server:
\> services load httpd

4. If the service is listed and not running, type the following to start the HTTP Web 
Server:
\> services start HTP0:
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5. To restart the Web Server, type:
\> services refresh HTP0:

This will cause the Web Server to reload any information pertaining to the Web Server 
in the registry. For additional information on the registry entries, see "Web Server Regis-
try Settings" on page C-4.

To configure the Web Server to allow access to the Web and Net administration pages:

1. On the Pegaso create the following registry entries:
[HKEY_LOCAL_MACHINE\COMM\HTTPD\VROOTS\/NetAdmin]

“Default” = “\windows\natadmin.dll”

[HKEY_LOCAL_MACHINE\COMM\HTTPD\VROOTS\/WebAdmin]

“Default” = “\windows\httpdadm.dll”

2. In a Command Prompt window on the Terminal, type the following:
\> services refresh HTP0:

Setting up a User
The following example demonstrates how to set up a user named Testuser in a group 
called Testgroup. 

To configure User and Group Permissions for the Web Server: 

1. On the Pegaso, launch Internet Explorer and type the following address in the 
address bar: http://localhost/NetAdmin. The Web-based network configuration 
utility appears. 

2. Fill in the Enter new password and Confirm new password boxes, then click Submit 
on the bottom of the page. 

3. On the menu bar of the displayed web page, click the User Accounts link. The 
Enter Network Password dialog box appears.

4. Type Admin in the User Name box, and type the password that you specified above 
in the Password box. Leave the Domain box empty. 

5. Click OK. The User Manager Setup page appears. 

6. In the Logon Name dialog, type Testuser in the Create a new user box, then click 
Create.The User Manager Setup page appears. 

7. On the User Configuration page, type a password for Testuser, confirm the pass-
word, and then click Create Account. The new user will appear below the Logon 
Name box on the User Manager Setup page. 

8. In the User Group Setup box, type Testgroup in the Create a new group box. Click 
Create. 

http://localhost/NetAdmin
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9. Click Return to user configuration page to return to the User Manager Setup page. 
The new group will appear below the Group Name box on the User Manager Setup 
page.

10. Click Modify beside the Group Name box containing Testgroup. The Group Con-
figuration page appears. 

11. Select the check box in the Member of group? column for Testuser, and then 
click Submit Changes. 

You have now added Testuser to the Testgroup group.

Testing the Web Server
After you have created your user accounts and groups for the Web Server, you can test 
the Web Server by launching the Web Server configuration page from a host PC. This 
will demonstrate that your user has been granted administrative rights for the Web 
Server and therefore can access any virtual directory on the Web Server.

To launch the Web Server configuration page from your host PC: 

1. On the Pegaso, verify that the Connected Network icon appears on the taskbar. This 
icon indicates you are connected to the network. 

2. Double-click the Network icon, and then select the IP Information tab to obtain the 
Pegaso’s IP address. 

3. On the PC, launch Internet Explorer and type the following information in the 
address bar: http://<IP address from Pegaso>/Webadmin. 

4. The Web Server Login dialog appears. Type Admin in the User Name box and enter 
the password you specified. Click OK, and the Web Server Configuration page will 
appear.

5. Scroll to the bottom of the page, and click Modify to the right of the Default Website 
box. The Default Website page appears.

6. Click the link to Configure the Virtual Directories. The Virtual Directory Configuration 
page appears. 

7. Verify that the following virtual directories are listed on the page: 

/WebAdmin/ 

/NetAdmin/ 

You can also create users programmatically by calling the NTLMSetUserInfo function. 
Windows CE also exposes the NTLMDeleteUser function, which is used to delete a user 
from the local database, and the NTLMEnumUser function, which is used to enumerate 
users in the local database. 

http://<IP address from Falcon 44XX>/Webadmin
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8. Click Return to the Default Website configuration page. The Default Website page 
appears. 

9. Click Configure the Administrative Users for this Website. The Administrative Users 
page appears. 

10. Select Enabled for Testuser, and then click Update. A message telling you that 
your modifications have been saved and asking you to restart the Web Server 
appears at the top of the page. 

11. To restart the Web Server, select Restart Web Server from the menu bar. 

Launching the Network Administration Page
To launch the network administration page from your host PC: 

1. Open Internet Explorer and type the following information in the address bar:  
http://<IP address from Pegaso>/NetAdmin. A dialog box asking for the user name 
and password appears. 

2. Type Testuser in the User name box and the password you created for this user 
in the Password box, and then click OK. The Network Administration page appears. 

Web Server Registry Settings
To gain access to a virtual path, a user must be authenticated using NTLM authentica-
tion or Basic authentication. Specify the authentication level by setting the “a” value for 
each virtual path. 

For more information on the registry settings and what each key represents, see the 
Windows® CE SDK help documentation included with embedded Visual C++ 4.0 
SP2. The help file contains a wealth of information on this topic.

Adding these values will create virtual root directories for the Basic and  
NTLM-based authentication methods.
[HKEY_LOCAL_MACHINE\COMM\HTTPD\VROOTS\/WebAdmin]
@="\\windows\\httpdadm.dll"
"a"=dword:0
[HKEY_LOCAL_MACHINE\COMM\HTTPD\VROOTS\/BasicOnly]
@="\\"
"a"=dword:1
"Basic"=dword:1
"NTLM"=dword:0
[HKEY_LOCAL_MACHINE\COMM\HTTPD\VROOTS\/NTLMOnly]
@="\\"
"a"=dword:1
"Basic"=dword:0
"NTLM"=dword:1
[HKEY_LOCAL_MACHINE\COMM\HTTPD\VROOTS\/BothAuth]
@="\\"
"a"=dword:1
"Basic"=dword:1
"NTLM"=dword:1

http://<IP address from Falcon 44XX>/NetAdmin
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Creating and Using an ISAPI Service
Developers can create an ISAPI service written in eVC++ to access the APIs available on 
the Terminal. The two sample .dlls below demonstrate setting and getting a few of the 
configurable items available in the Pegaso SDK. 

Setting Configuration Items
The following example shows how to set the Code 39 minimum label length to 10 char-
acters:

1. Create a virtual directory under the root called SetSym and set the Default regis-
try entry to SetSym.dll while making sure the full path is included.
[HKEY_LOCAL_MACHINE\COMM\HTTPD\VROOTS\/SetSym]

@="\\windows\\SetSym.dll"

2. Restart the Web Server as described on page C-2.

3. Enter the following information into Internet Explorer on the Terminal or host 
PC:
http://<ip address of Terminal>/SetSym?CD39MIN&10

Getting Configuration Items
The following example demonstrates how to get all the settings for Code 39:

1. Create a virtual directory under the root called GetSym and set the Default regis-
try entry to GetSym.dll while making sure the full path is included.
[HKEY_LOCAL_MACHINE\COMM\HTTPD\VROOTS\/GetSym]

@="\\windows\\GetSym.dll"

2. Restart the Web Server as described in the first section. (C-2)

3. Enter the following information into Internet Explorer on the Terminal or desktop 
computer:
 http://<ip address of Terminal>/GetSym?C39

These two samples are only the beginning of what can be accomplished with the Web 
Server. Please note that ISAPI is currently the only method of server-side method invo-
cation. Please consult the Help file associated with the SDK and eVC++ for more infor-
mation on ISAPI and Web Server features.

CAUTION

Setting the "a" value to zero (0) enables anonymous users to have access to all files in the 
virtual directory. This potentially opens the device up to hackers. Setting this value to 
zero (0) is permissible for internal development and testing purposes. However, you 
should never ship a Web Server device with the "a" value set to zero (0) for any configura-
tion page.

To set the password for the entire Web Server device for Basic authentication, you can 
create a configuration application that runs on the device and calls the SetPassword 
function. Setting the password programmatically through SetPassword is the equivalent 
of the device password setting that you add in Control Panel.
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Appendix D
SNMP Interface

Overview

SNMP Concepts
Simple Network Management Protocol (SNMP) is a standardized protocol for network 
management services using a client/server model. The network management program 
(client) issues queries and commands to the remote device (agent/server). The protocol 
itself defines a number of variable types and structures, and the rules for using them for 
data transfer. Using these variable types and rules, there are a number of standard vari-
ables that are supported by all SNMP agents. These standards include network address-
ing (IP address, subnet mask, etc.), and network statistics (total packets, bad packets, 
etc.). 

FMU uses Simple Network Management Protocol (SNMP) to perform many of its 
functions. When the Terminal Configuration or Terminal Report function is selected, 
SNMP is used to query the Terminal for its current Configuration settings, as well as 
current status information such as battery status and memory usage. In the same func-
tion, SNMP is used to update Terminal Configuration settings when directed to. 
SNMP is also used by the FMU Servers to perform the automated Group Configura-
tion update. The Server issues SNMP queries to discover the current Terminal Configu-
ration, then uses SNMP commands to update any Configuration settings that need it. 

MIB Files
A Management Information Base (MIB) is a file that defines a set of SNMP variables, 
their types and usage. There are a number of standard MIBs available, depending on the 
information being managed. 

Datalogic MIBs
Beyond the standard values, SNMP allows manufacturers to define their own private 
MIBs. For example, Datalogic has been assigned an MIB by the Internet Assigned 
Numbers Authority that allows Datalogic to define SNMP values relating specifically to 
devices that we manufacture. Within the Datalogic MIB, several categories of values 
have been defined including scanner Configurations, Terminal power Configurations 
and Terminal network parameters. 
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The format of an MIB follows rules laid out in the appropriate standards, allowing the 
manufacturers of network management tools such as HP OpenView and CastleRock 
SNMPc to make use of the MIBs developed by manufacturers. So by following the pro-
cedures used by the management tool, the MIB can be processed by the tool allowing 
the proper display of SNMP values retrieved from the agent. 

For example, if the Datalogic MIB is loaded into OpenView, the administrator can then 
view all of the values defined by Datalogic using the names assigned by Datalogic, as 
well as a brief explanation of what each value represents. This will also allow the admin-
istrator to update most values, and provides range checking information for the tool to 
take advantage of. The current Datalogic MIB can be found on the Datalogic Mobile 
website at www.mobile.datalogic.com in the Downloads area.

Additional Resources
Additional information on SNMP can be found at the following websites:

www.snmplink.org

www.snmpworld.com

www.simpleweb.com

http://www.mobile.datalogic.com
http://www.snmplink.org
http://www.snmpworld.com
http://www.simpleweb.com
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Appendix E
Cable & Connector Configurations

Introduction
The following pages contain information about standard interface cables for use in 
interconnecting the Dock to power and/or peripheral devices. 

General Specifications

Wire Requirements
• Cable length should not exceed 15 feet.

• Wire gauge:  
5V and GND  — 26 AWG min, 24 AWG recommended.  
All others 28-26 AWG.

Supply Voltage
Current power supply voltage = 5V, 3 amp.

Docking Connector

Table E-1. Docking Connector Pin Definitions

PIN Signal Description

1 PWR GND GND/Return

2 Cradle IN When Grounded Mobile computer detects it is in the cradle

3 NC No Connect

4 USB_N USB D- Signal

5 USB_P USB D+ Signal

6 GND GND/Return

7 VBUS USB VBUS Signal

8 USB ID USB OTG ID Signal

9 TXD RS232 TXD (Output from Mobile Computer)

10 RXD RS232 RXD (Input to Mobile Computer)

11 RTS RS232 RTS (Output from Mobile Computer)
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USB Cable
Figure E-1 illustrates the connector configuration of the USB cable for the Pegaso.

Figure E-1. USB Connector Configurations 

12 CTS RS232 CTS (Input to Mobile Computer)

13 DTR RS232 DTR (Output from Mobile Computer)

14 DSR RS232 DSR (Input to Mobile Computer)

15 NC No Connect

16 POWER IN Power Into Mobile Computer

PIN Signal Description

62” +/- 2”

Power jack 
PC END PEGASO

  END
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Appendix F
Programming Parameters

Overview
This section contains information about programmable settings for the Pegaso with 
Windows CE. Use the Falcon Management Utility (FMU), the Decoding Control 
Panel applets, or the bar codes provided in Appendix G to program the Pegaso.

Table F-2 starting on page F-3 provides the following information:

• Code Parameter is the “human” name for the programming option.

• I.D. # is the “decoder” name for the programming option. For example, to set a 
Code 39 minimum label length, use I.D. 0120. Programming I.D. numbers given 
in this appendix can be used with all programming methods.

• On/Off is a toggle. 1 turns the parameter on, and 0 turns it off.

• Acceptable Input gives the settings or range of settings for each code parameter.

• Defaults indicates how the parameter is set when the predefined default FF39, 
FF3A, or FF3B is selected.

• Minimum (FF39) turns every on/off parameter off and sets all minimum and 
Maximum Label Lengths to the lowest values.

• Maximum (FF3A) turns every on/off parameter on, sets all Minimum Label 
Lengths to the lowest values, and sets all Maximum Label Lengths to the highest 
values. Use this default for troubleshooting; it provides the best settings for read-
ing an unknown bar code symbology and can identify the symbology of scanned 
bar codes. 

• Factory (FF3B) is the factory setting installed on the Pegaso. This default set will 
work for most applications. To reset the Pegaso to the original defaults, scan the 
Factory bar code on page G-2.
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Programming Codes Without Parameters
The following table describes the functions of special bar codes that take no parameters:

Table F-1. Programming Codes Without Parameters 

Code 
Parameter I.D. # Function

Defaults  
Minimum FF39 Turns every On/Off parameter off and sets all minimum 

and Maximum Label Lengths to the lowest values.

Defaults  
Maximum FF3A

Turns every On/Off parameter on and sets all minimum 
and Maximum Label Lengths to the highest values. This 
default set is normally used only for troubleshooting. It 
gives the best chance of reading an unknown bar code 
symbology and also identifies the symbology of each bar 
code scanned.

Defaults  
Factory FF3B

This is the default parameter settings that was installed at 
the factory. This default set will work for most applications.

Defaults  
Registry FF3C

This restores all parameter settings to the values that 
exist in the registry. This is useful for restoring parameters 
to a known working set of values which have been saved 
using code parameter FF3F.

Exit and 
Restore FF3D Stops a label programming sequence and restores all 

parameter settings to the values that exist in the registry.

Exit and 
Save FF3E Stops a label programming sequence. The last valid 

parameter settings are left intact.

Exit and 
Commit FF3F

Stops a label programming sequence and writes all 
parameter settings into the registry. This can be used to 
save a customized set of parameter settings for restoring 
later via parameter FF3C.
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Bar Code Parameters
The following table lists the standard customer programmable settings for the Pegaso.

Table F-2. Programmable Standard Bar Code Settings 

Code Parameter/ Description I.D. # Acceptable 
Input

Defaults

Min Max Factory

Codabar Enter 1 for On 
and 0 for Off.

Enable Enables/disables the Codabar symbology. 0300 On / Off Off On On

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0301 On / Off Off On Off

Enable 
Checksum

Requires the use of checksum characters to 
verify a bar code.

0302 On / Off Off Off Off

Send Check-
sum

Instructs the terminal to include the checksum 
in the label transmission

0303 On / Off Off Off Off

Send Start/
Stop

Instructs the decoder to transmit the decoded 
start and stop characters of Codabar labels. 
The start and stop characters will both be 
translated as A, B, C, or D.

0305 On / Off Off On Off

Convert to 
CLSI

Restricts the Codabar decoder to only read 
labels that conforms to "CLSI" specifications. 
Label length must be 14, and the data is split 
into fields of 1, 4, 5, and 4 characters sepa-
rated by spaces.

0306 On / Off Off Off Off

Allow Wide 
Intercharac-
ter Gaps

Allows wide gaps to appear between charac-
ters in a label.

0307 On / Off Off On On

Minimum 
Label Length

Set the minimum label length to be less than 
or equal to maximum label length.

0320 01 - 50 01 01 04

Maximum 
Label Length

This feature specifies the maximum allowable 
length of a Codabar label. The length includes 
check and data characters. Maximum Label 
Length should be greater than or equal to Min-
imum Label Length.

0321 01 - 50 01 50 20

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0322 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent when parameter Send Code ID (Index 
0025) is set to 3. "ASCII" code zero (null) is 
used to indicate that an identifier is not to be 
sent for the symbology.

0323

Any single 
ASCII 

character
(00 = Off)

'I' 'I' 'I'
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Code 39 Enter 1 for On 
and 0 for Off.

Enable Enables/disables the Code 39 symbology. 0100 On / Off Off On On

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0101 On / Off Off On Off

Enable 
Checksum

Requires the use of checksum characters to 
verify a bar code.

0102 On / Off Off Off Off

Send Check-
sum

Instructs the terminal to include the checksum 
in the label transmission.

0103 On / Off Off Off Off

Full ASCII 
Mode

Supports the entire ASCII character set by 
replacing various encoded ASCII characters 
with their corresponding "ASCII" equivalents.

0105 On / Off Off On On

Minimum 
Label Length

Set the minimum label length to be less than 
or equal to maximum label length.

0120 01 - 50 01 01 01

Maximum 
Label Length

This feature specifies the maximum allowable 
length of a Code 39 label. The length includes 
check and data characters. Maximum Label 
Length should be greater than or equal to Min-
imum Label Length.

0121 01 - 50 01 50 20

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0122 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent when parameter Send Code ID (Index 
0025) is set to 3. "ASCII" code zero (null) is 
used to indicate that an identifier is not to be 
sent for the symbology.

0123

Any single 
ASCII 

character
(00 = Off)

'C' 'C' 'C'

Code 93 Enter 1 for On 
and 0 for Off.

Enable Enables/disables the Code 93 symbology. 0400 On / Off Off On Off

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0401 On / Off Off On Off

Minimum 
Label Length

Set the minimum label length to be less than 
or equal to maximum label length.

0420 01 - 50 01 01 02

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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Maximum 
Label Length

This feature specifies the maximum allowable 
length of a Code 93 label. The length includes 
check and data characters. Maximum Label 
Length should be greater than or equal to Min-
imum Label Length.

0421 01 - 50 01 50 20

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0422 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent when parameter Send Code ID (Index 
0025) is set to 3. "ASCII" code zero (null) is 
used to indicate that an identifier is not to be 
sent for the symbology.

0423

Any single 
ASCII 

character
(00 = Off)

'L' 'L' 'L'

Code 128 Enter 1 for On 
and 0 for Off.

Enable Enables/disables the Code 128 symbology. 0408 On / Off Off On On

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0409 On / Off Off On Off

Enable UCC/
EAN-128

Instructs the decoder to recognize UCC-128 
versions of Code 128 labels and process them 
differently by changing the Code ID, and 
replacing each occurrence of the FNC1 char-
acter with GS ("ASCII" 29) characters.

040C On / Off Off On Off

ISBT Concat-
enation

Instructs the decoder to concatenate Code 
128 labels conforming to the ISBT 128 stan-
dard.

040E On / Off Off Off

Minimum 
Label Length

Set the minimum label length to be less than 
or equal to maximum label length.

0424 01 - 50 01 01 02

Maximum 
Label Length

This feature specifies the maximum allowable 
length of a Code 128 label. The length 
includes check and data characters. Maximum 
Label Length should be greater than or equal 
to Minimum Label Length.

0425 01 - 50 01 50 20

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0426 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) sent 
when parameter Send Code ID (Index 0025) 
is set to 3. "ASCII" code zero (null) is used to 
indicate that an identifier is not to be sent for 
the symbology.

0427

Any single 
ASCII 

character
(00 = Off)

'K' 'K' 'K'

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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European Article Numbering-13 (EAN-
13) 

Enter 1 for On 
and 0 for Off.

Enable Enables/disables the EAN-13 symbology. 0510 On / Off Off On On

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0511 On / Off Off On Off

Send Check 
Digit

Includes a check digit in the label which is 
transmitted.

0512 On / Off Off On Off

Send Sys-
tem Digit

This instructs the decoder to include the sys-
tem digit in the label transmission. For UPC-E, 
the system digit is zero. 

0513 On / Off Off On On

Convert EAN-
13 to ISBN

This instructs the decoder to identify ISBN 
labels and append the check digit (per ISBN 
guidelines) to the end of the label.

0514 On / Off Off Off Off

Convert EAN-
13 to ISSN

This instructs the decoder to identify ISSN 
labels and append the check digit (per ISSN 
guidelines) to the end of the label.

0515 On / Off Off Off Off

Enable EAN 
4-Digit Price/
Weight 
Check Digit

Requires the use of a 4-digit price/weight 
check digit to verify a bar code.

0516 On / Off Off Off Off

Enable EAN 
5-Digit Price/
Weight 
Check Digit

Requires the use of a 4-digit price/weight 
check digit to verify a bar code.

0517 On / Off Off Off Off

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0524 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent by the decoder when parameter Send 
Code ID (Index 0025) is set to 3. "ASCII" code 
zero (null) is used to indicate that an identifier 
is not to be sent for the symbology.

0525

Any single 
ASCII 

character
(00 = Off)

'M' 'M' 'M'

European Article Numbering-8 (EAN-8) Enter 1 for On 
and 0 for Off.

Enable Enables/disables the EAN-8 symbology. 0518 On / Off Off On On

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0519 On / Off Off On Off

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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Send Check 
Digit

Instructs the terminal to include the check digit 
in the label transmission.

051A On / Off Off On Off

Convert EAN-
8 to EAN-13

Instructs the decoder to expand EAN-8 labels 
to their EAN-13 equivalents. Any EAN-13 
parameters will then apply to the result.

051B On / Off Off On Off

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0526 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent by the decoder when parameter Send 
Code ID (Index 0025) is set to 3. "ASCII" code 
zero (null) is used to indicate that an identifier 
is not to be sent for the symbology.

0527

Any single 
ASCII 

character
(00 = Off)

'G' 'G' 'G'

Interleaved 2 of 5 Enter 1 for On 
and 0 for Off.

Enable
Enables/disables the Interleaved 2 of 5 sym-
bology.

0210 On / Off Off On On

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0211 On / Off Off On Off

Enable 
Checksum

Requires the use of checksum characters to 
verify a bar code.

0212 On / Off Off Off Off

Send Check-
sum

Instructs the terminal to include the checksum 
in the label transmission.

0213 On / Off Off Off Off

Enable Case 
Code

Restricts Interleaved 2 of 5 label lengths to 
only 6 and 14 data characters. Enabling this 
parameter overrides the minimum and maxi-
mum length values.

0214 On / Off Off Off Off

Minimum 
Label Length

Set the minimum label length to be less than 
or equal to maximum label length.

0228 02 - 50 02 02 06

Maximum 
Label Length

This feature specifies the maximum allowable 
length of a Interleaved 2 of 5 label. The length 
includes check and data characters. Maximum 
Label Length should be greater than or equal 
to Minimum Label Length.

0229 02 - 50 02 50 10

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

022A 01 - 04 01 02 01

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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User ID

Specifies the symbology identifier (if any) that 
is sent by the decoder when parameter Send 
Code ID (Index 0025) is set to 3. "ASCII" code 
zero (null) is used to indicate that an identifier 
is not to be sent for the symbology.

022B

Any single 
ASCII 

character
(00 = Off)

'B' 'B' 'B'

Matrix 2 of 5 Enter 1 for On 
and 0 for Off.

Enable Enables/disables the Matrix 2 of 5 symbology. 0208 On / Off Off On Off

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0209 On / Off Off On Off

Enable 
Checksum

Requires the use of checksum characters to 
verify a bar code.

020A On / Off Off Off Off

Send Check-
sum

Instructs the terminal to include the checksum 
in the label transmission.

020B On / Off Off Off Off

Minimum 
Label Length

Set the minimum label length to be less than 
or equal to maximum label length.

0224 01 - 50 01 01 06

Maximum 
Label Length

This feature specifies the maximum allowable 
length of a Matrix 2 of 5 label. The length 
includes check and data characters. Maximum 
Label Length should be greater than or equal 
to Minimum Label Length.

0225 01 - 50 01 50 10

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0226 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent by the decoder when parameter Send 
Code ID (Index 0025) is set to 3. "ASCII" code 
zero (null) is used to indicate that an identifier 
is not to be sent for the symbology.

0227

Any single 
ASCII 

character
(00 = Off)

'D' 'D' 'D'

MSI Enter 1 for On 
and 0 for Off.

Enable Enables/disables the MSI symbology. 0608 On / Off Off On Off

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0609 On / Off Off On Off

Require  
2 Check Dig-
its

An MSCI label must contain 2 check digits. 060A On / Off Off Off Off

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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Send Check 
Digits

This instructs the decoder to include any 
enabled check digit(s) in the label which is 
transmitted.

060B On / Off Off On Off

2nd Check 
Digit Mod 11

Instructs the decoder to interpret any second 
MSI check digit as modulo 11 instead of mod-
ulo 10.

060C On / Off Off Off Off

Minimum 
Label Length

Set the minimum label length to be less than 
or equal to maximum label length.

0624 01 - 15 01 01 04

Maximum 
Label Length

This feature specifies the maximum allowable 
length of an MSI label. The length includes 
check and data characters. Maximum Label 
Length should be greater than or equal to Min-
imum Label Length.

0625 01 - 15 01 15 10

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0626 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent by the decoder when parameter Send 
Code ID (Index 0025) is set to 3. "ASCII" code 
zero (null) is used to indicate that an identifier 
is not to be sent for the symbology.

0627

Any single 
ASCII 

character
(00 = Off)

'H' 'H' 'H'

Pharmacode 39 (Code 32) Enter 1 for On 
and 0 for Off.

Enable
Enables/disables the Pharmacode 39 (Code 
32) symbology.

0110 On / Off Off On Off

Send Check-
sum

Instructs the terminal to include the checksum 
in the label transmission.

0112 On / Off Off Off Off

Send Start/
Stop

Instructs terminals to prefix a Pharmacode 39 
label with an “A” prior to transmission.

0113 On / Off Off On Off

User ID

Specifies the symbology identifier (if any) that 
is sent when parameter Send Code ID (Index 
0025) is set to 3. "ASCII" code zero (null) is 
used to indicate that an identifier is not to be 
sent for the symbology.

0127

Any single 
ASCII 

character
(00 = Off)

'Y' 'Y' 'Y'

RSS-14 Enter 1 for On 
and 0 for Off.

RSS-14 
Enable Enables/disables the RSS-14 symbology. 0800 On / Off Off On On

RSS-14 to 
UCC-EAN 
128

Instructs the decoder to transmit the label data 
as one or more UCC-128 labels. The trans-
mission will use the UCC-128 AIM identifier.

0804 On / Off Off On Off

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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If RSS-14, RSS-Expanded, RSS-Limited, or RSS-Composite symbologies are enabled for UCC-EAN 
128, then that setting is also enabled for all other RSS symbologies.

NOTE: For the 2D Imager, RSS-Expanded User Code ID is used for RSS-14

RSS Limited Enter 1 for On 
and 0 for Off.

RSS Limited 
Enable Enables/disables the RSS Limited symbology. 0808 On / Off Off On On

RSS Limited 
to UCC-EAN 
128

Instructs the decoder to transmit the label data 
as one or more UCC-128 labels. The trans-
mission will use the UCC-128 AIM identifier.

080C On / Off Off On Off

If RSS-14, RSS-Expanded, RSS-Limited, or RSS-Composite symbologies are enabled for UCC-EAN 
128, then that setting is also enabled for all other RSS symbologies.

NOTE: For the 2D Imager, RSS-Expanded User Code ID is used for RSS-Limited

RSS Expanded Enter 1 for On 
and 0 for Off.

RSS 
Expanded 
Enable

Enables/disables the RSS Expanded symbol-
ogy.

0810 On / Off Off On On

RSS 
Expanded to 
UCC-EAN 
128

Instructs the decoder to transmit the label data 
as one or more UCC-128 labels. The trans-
mission will use the UCC-128 AIM identifier.

0804 On / Off Off On Off

RSS 
Expanded 
Minimum

Set the minimum bar code label length to be 
less than or equal to maximum label length.

0824 1 - 74 1 74 1

RSS 
Expanded 
Maximum

This feature specifies the maximum allowable 
length of a label. The length includes check 
and data characters, if applicable. Maximum 
Label Length should be greater than or equal 
to Minimum Label Length.

0825 1 - 74 1 74 74

RSS 
Expanded 
User Code ID

Specifies the symbology identifier (if any) that 
is sent when parameter Send Code ID (Index 
0025) is set to 3. "ASCII" code zero (null) is 
used to indicate that an identifier is not to be 
sent for the symbology.

0827

Any single 
ASCII char-
acter (00 = 

Off)

‘R’ ‘R’ ‘R’

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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Standard 2 of 5 Enter 1 for On 
and 0 for Off.

Enable
Enables/disables the Standard 2 of 5 symbol-
ogy.

0200 On / Off Off On Off

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0201 On / Off Off On Off

Enable 
Checksum

Requires the use of checksum characters to 
verify a bar code

0202 On / Off Off Off Off

Send Check-
sum

Instructs the terminal to include the checksum 
in the label transmission.

0203 On / Off Off Off Off

Use 2-bar 
Start/Stop

Allows the terminal to recognize labels that 
are printed using only two bars for start/stop 
characters.

0204 On / Off Off Off Off

Minimum 
Label Length

Set the minimum label length to be less than 
or equal to maximum label length.

0220 01 - 50 01 01 06

Maximum 
Label Length

This feature specifies the maximum allowable 
length of a Standard 2 of 5 label. The length 
includes check and data characters. Maximum 
Label Length should be greater than or equal 
to Minimum Label Length.

0221 01 - 50 01 50 10

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0222 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent when parameter Send Code ID (Index 
0025) is set to 3. "ASCII" code zero (null) is 
used to indicate that an identifier is not to be 
sent for the symbology.

0223

Any single 
ASCII 

character
(00 = Off)

'F' 'F' 'F'

Trioptic Enter 1 for On 
and 0 for Off.

Enable Enables/disables the Trioptic symbology. 0108 On / Off Off On Off

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0109 On / Off Off On Off

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0124 01 - 04 01 02 01

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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User ID

Specifies the symbology identifier (if any) that 
is sent when parameter Send Code ID (Index 
0025) is set to 3. "ASCII" code zero (null) is 
used to indicate that an identifier is not to be 
sent for the symbology

0125

Any single 
ASCII 

character
(00 = Off)

'X' 'X' 'X'

Universal Product Code-A (UPC-A) Enter 1 for On 
and 0 for Off.

Enable Enables/disables the UPC-A symbology. 0500 On / Off Off On On

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0501 On / Off Off On Off

Send Check 
Digit

Includes check digit in the label which is trans-
mitted.

0502 On / Off Off On Off

Send Sys-
tem Digit

Includes the system digit in the label transmis-
sion. For UPC-A, the system digit is always 
zero. 

0503 On / Off Off On On

Convert UPC-
A to EAN-13

Instructs the decoder to expand UPC-A labels 
to their EAN-13 equivalents. Any EAN-13 
parameters will then apply to the result.

0504 On / Off Off On Off

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0520 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) sent 
when parameter Send Code ID (Index 0025) 
is set to 3. "ASCII" code zero (null) is used to 
indicate that an identifier is not to be sent for 
the symbology.

0521

Any single 
ASCII 

character
(00 = Off)

'A' 'A' 'A'

Universal Product Code-E (UPC-E) Enter 1 for On 
and 0 for Off.

Enable Sys-
tem Digit 0

Enables/disables UPC-E labels with a system 
digit of zero.

0508 On / Off Off On On

Enable 
Aggressive 
Decoding

Enables more aggressive decoding algorithms 
to be used in order to scan hard to read 
labels.

0509 On / Off Off On Off

Send Check 
Digit

Includes the check digit in the label which is 
transmitted.

050A On / Off Off On Off

Send Sys-
tem Digit

This instructs the decoder to include the sys-
tem digit in the label transmission. For UPC-E, 
the system digit is zero. 

050B On / Off Off On Off

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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Convert UPC-
E to UPC-A

Instructs the decoder to expand UPC-E labels 
to their UPC-A equivalents. Any UPC-A 
parameters will then apply to the result.

050C On / Off Off On Off

Read Verifi-
cation

Sets the number of times a label must be read 
before it is transmitted.

0522 01 - 04 01 02 01

User ID

Specifies the symbology identifier (if any) that 
is sent by the decoder when parameter Send 
Code ID (Index 0025) is set to 3. "ASCII" code 
zero (null) is used to indicate that an identifier 
is not to be sent for the symbology.

0523

Any single 
ASCII 

character
(00 = Off)

'E' 'E' 'E'

UPC/EAN Extensions Enter 1 for On 
and 0 for Off.

Enable 2-
Digit Exten-
sions

Requires a 2 digit extension (supplemental 
label) to be verified for a successful decode of 
a label.

051C On / Off Off On On

Enable 5-
Digit Exten-
sions

Requires a 5 digit extension (supplemental 
label) to be verified for a successful decode of 
a label.

051D On / Off Off On On

Require 
Extensions

Instructs the decoder to require any enabled 
UPC/EAN extensions (supplemental labels) to 
be with a label in order for a scan to be suc-
cessful.

051F On / Off Off Off Off

Read Verifi-
cation

Sets the number of times an extension (sup-
plemental label) must be read before it is 
included in the transmission of the base UPC/
EAN label.

0528 01 - 04 01 01 01

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory
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Table F-3. Other Controls 

Code Parameter/ Description I.D. # Acceptable 
Input

Defaults

Min Max Factory

Other Controls Enter 1 for On and 0 for Off.

Enable Label 
Programming

Enables/disables the ability to per-
form label programming.

FF00 On / Off On On On

Beeper Volume Adjusts the beeper volume. FF20

00 = Off
00 - 09

(01 = Lowest;
07 = Highest;
08 = Higher;
09 = Lower)

07 07 07

Long Range 
Trigger Mode

Selects the Long Range Trigger 
mode.

0000
On = Release 

Scan Off = 
Spot Timeout

Off Off Off

Spotting Beam 
Enable Enables/disables the Spotting Beam 0001 On / Off On On On

Spotting Beam 
Timeout

Sets the duration of the spotting 
beam before it automatically turns off.

0023

00 = 0.25 sec.
01 = 0.5 sec.
02 = 1.0 sec.
03 = 1.5 sec.
04 = 2.0 sec.

01 01 01

Release Scan 
Timeout

Sets the duration of the scan before it 
turns off.

0024 1-10 02 02 02

Number of 
Good-Read 
Beeps

Determines the number of beeps for 
a good read indicator.

0020 01 - 04 01 01 01

Good-Read 
Beep Tone

Adjusts the pitch of the beeper fre-
quency.

0021
00 - 07

(00 = Lowest;
07 = Highest)

00 00 00

Good-Read 
Beep Duration

Determines the duration of a good 
read beep.

0022

00 = 0.07 sec.
01 = 0.13 sec.
02 = 0.18 sec.
03 = 0.36 sec.

00 00 00

Send Symbol-
ogy Identifiers

Specifies the symbology identifier (if 
any) that is sent by the decoder when 
parameter Send Code ID (Index 
0025) is set to 3. "ASCII" code zero 
(null) used to indicate an identifier not 
to be sent for the symbology.

0025

00 = Off
01 = DLM IDs*
02 = AIM IDs
03 = User IDs

00 01 00
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Table F-4. Datalogic Label IDs

Table F-5. ASCII/Hex Conversion Table

Label Prefix Indicates a label prefix. 0026

Any single 
ASCII charac-

ter
(00 = Off)

Non
e

Non
e

None

Label Suffix Indicates a label suffix. 0027

Any single 
ASCII charac-

ter
(00 = Off)

CR CR CR

Code Parameter/ Description I.D. #
Acceptable 

Input

Defaults

Min Max Factory

DLM Label IDs

UPC-A = A Code 128 = K Trioptic = X

UPC-E = E I 2 of 5 = B Pharmacode 39 = Y

EAN-8 = G S 2 of 5 = F RSS-14 = P

EAN 13 = M M 2 of 5 = D RSS Limited = Q

Code 39 = C Code 93 = L RSS Expanded = R

Codabar = I MSI = H

ASCII Hex ASCII Hex ASCII Hex ASCII Hex

NUL 00 SP 20 @ 40 60

SOH 01 ! 21 A 41 a 61

STX 02 “ 22 B 42 b 62

ETX 03 # 23 C 43 c 63

EOT 04 $ 24 D 44 d 64

ENQ 05 % 25 E 45 e 65

ACK 06 & 26 F 46 f 66

BEL 07 & 26 G 47 g 67

BS 08 ( 28 H 48 h 68

HT 09 ) 29 I 49 i 69

LF 0A * 2A J 4A j 6A

VT 0B + 2B K 4B k 6B

FF 0C , 2C L 4C l 6C

CR 0D - 2D M 4D m 6D

SO 0E . 2E N 4E n 6E

SI 0F / 2F O 4F o 6F

DLE 10 0 30 P 50 p 70

DC1 11 1 31 Q 51 q 71
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DC2 12 2 32 R 52 r 72

DC3 13 3 33 S 53 s 73

DC4 14 4 34 T 54 t 74

NAK 15 5 35 U 55 u 75

SYN 16 6 36 V 56 v 76

ETB 17 7 37 W 57 w 77

CAN 18 8 38 X 58 x 78

EM 19 9 39 Y 59 y 79

SUB 1A : 3A Z 5A z 7A

ESC 1B ; 3B [ 5B { 7B

FS 1C < 3C \ 5C | 7C

GS 1D = 3D ] 5D } 7D

RS 1E > 3E ^ 5E ~ 7E

US 1F ? 3F _ 5F DEL 7F

ASCII Hex ASCII Hex ASCII Hex ASCII Hex
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Appendix G
Programming Bar Codes

Overview
This appendix provides bar codes for common setup parameters for programming the 
Pegaso. Factory default settings are OUTLINED.

To make settings that are not provided in the chapter, you can design custom bar codes 
or use the Falcon Management Utility (FMU) to program the Pegaso. Refer to "Config-
uring the Pegaso", on page 2-1.

1D Symbologies
Symbologies and bar code setup parameters included in this appendix are:

• "Predefined Defaults" on page G-2.

• "Codabar" starting on page G-2.

• "Code 39" starting on page G-5.

• "Code 93" starting on page G-7.

• "Code 128" on page G-9.

• "EAN-13" starting on page G-10.

• "EAN-8" on page G-12.

• "Interleaved 2 of 5" on page G-13 

• "Matrix 2 of 5" on page G-15

• "MSI" starting on page G-17.

• "Pharmacode 39 (Code 32)" on page G-19.

• "RSS-14" on page G-19.

• "RSS Limited" on page G-19.

• "RSS Expanded" on page G-21.

• "Standard 2 of 5" starting on page G-22.

• "Trioptic" on page G-23.

• "UPC-A" starting on page G-25.

• "UPC-E" on page G-26.

• "UPC/EAN Extensions" on page G-27.

• "Other Controls" starting on page G-27.

Depending on which Pegaso options you have, some programming parameters may not 
be available on your unit. Refer to Table F-2 on page F-3 for specific details on which 
parameters are applicable.
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Predefined Defaults 

Codabar

Minimum Registry

Maximum
Restore 

From 
Registry

Factory
Save To 
Registry

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

ENABLE CHECKSUM

On Off

SEND CHECKSUM

On Off

SEND START/STOP

On Off

* / / F F 3 9 F F 3 F * * / / F F 3 C F F 3 F *

* / / F F 3 A F F 3 F * * / / F F 3 D *

* / / F F 3 B F F 3 F * * / / F F 3 F *

* / / 0 3 0 0 1 F F 3 E * * / / 0 3 0 0 0 F F 3 E *

* / / 0 3 0 1 1 F F 3 E * * / / 0 3 0 1 0 F F 3 E *

* / / 0 3 0 2 1 F F 3 E * * / / 0 3 0 2 0 F F 3 E *

* / / 0 3 0 3 1 F F 3 E * * / / 0 3 0 3 0 F F 3 E *

* / / 0 3 0 5 1 F F 3 E * * / / 0 3 0 5 0 F F 3 E *
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CONVERT TO CLSI

On Off

ALLOW WIDE INTERCHARACTER GAPS

On Off

MINIMUM LENGTH

1 30

4 40

10 50

20

MAXIMUM LENGTH

1 30

10 40

20 50

* / / 0 3 0 6 1 F F 3 E * * / / 0 3 0 6 0 F F 3 E *

* / / 0 3 0 7 1 F F 3 E * * / / 0 3 0 7 0 F F 3 E *

* / / 0 3 2 0 0 1 F F 3 E * * / / 0 3 2 0 3 0 F F 3 E *

* / / 0 3 2 0 0 4 F F 3 E * * / / 0 3 2 0 4 0 F F 3 E *

* / / 0 3 2 0 1 0 F F 3 E * * / / 0 3 2 0 5 0 F F 3 E *

* / / 0 3 2 0 2 0 F F 3 E *

* / / 0 3 2 1 0 1 F F 3 E * * / / 0 3 2 1 3 0 F F 3 E *

* / / 0 3 2 1 1 0 F F 3 E * * / / 0 3 2 1 4 0 F F 3 E *

* / / 0 3 2 1 2 0 F F 3 E * * / / 0 3 2 1 5 0 F F 3 E *
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READ VERIFICATION

1 3

2 4

* / / 0 3 2 2 0 1 F F 3 E * * / / 0 3 2 2 0 3 F F 3 E *

* / / 0 3 2 2 0 2 F F 3 E * * / / 0 3 2 2 0 4 F F 3 E *
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Code 39

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

ENABLE CHECKSUM

On Off

SEND CHECKSUM

On Off

FULL ASCII MODE

On Off

MINIMUM LENGTH

1 30

10 40

20 50

* / / 0 1 0 0 1 F F 3 E * * / / 0 1 0 0 0 F F 3 E *

* / / 0 1 0 1 1 F F 3 E * * / / 0 1 0 1 0 F F 3 E *

* / / 0 1 0 2 1 F F 3 E * * / / 0 1 0 2 0 F F 3 E *

* / / 0 1 0 3 1 F F 3 E * * / / 0 1 0 3 0 F F 3 E *

* / / 0 1 0 5 1 F F 3 E * * / / 0 1 0 5 0 F F 3 E *

* / / 0 1 2 0 0 1 F F 3 E * * / / 0 1 2 0 3 0 F F 3 E *

* / / 0 1 2 0 1 0 F F 3 E * * / / 0 1 2 0 4 0 F F 3 E *

* / / 0 1 2 0 2 0 F F 3 E * * / / 0 1 2 0 5 0 F F 3 E *
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MAXIMUM LENGTH

1 30

10 40

20 50

READ VERIFICATION

1 3

2 4

* / / 0 1 2 1 0 1 F F 3 E * * / / 0 1 2 1 3 0 F F 3 E *

* / / 0 1 2 1 1 0 F F 3 E * * / / 0 1 2 1 4 0 F F 3 E *

* / / 0 1 2 1 2 0 F F 3 E * * / / 0 1 2 1 5 0 F F 3 E *

* / / 0 1 2 2 0 1 F F 3 E * * / / 0 1 2 2 0 3 F F 3 E *

* / / 0 1 2 2 0 2 F F 3 E * * / / 0 1 2 2 0 4 F F 3 E *
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Code 93

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

MINIMUM LENGTH

2 30

10 40

20 50

MAXIMUM LENGTH

2 30

10 40

20 50

READ VERIFICATION

1 3

* / / 0 4 0 0 1 F F 3 E * * / / 0 4 0 0 0 F F 3 E *

* / / 0 4 0 1 1 F F 3 E * * / / 0 4 0 1 0 F F 3 E *

* / / 0 4 2 0 0 2 F F 3 E * * / / 0 4 2 0 3 0 F F 3 E *

* / / 0 4 2 0 1 0 F F 3 E * * / / 0 4 2 0 4 0 F F 3 E *

* / / 0 4 2 0 2 0 F F 3 E * * / / 0 4 2 0 5 0 F F 3 E *

* / / 0 4 2 1 0 2 F F 3 E * * / / 0 4 2 1 3 0 F F 3 E *

* / / 0 4 2 1 1 0 F F 3 E * * / / 0 4 2 1 4 0 F F 3 E *

* / / 0 4 2 1 2 0 F F 3 E * * / / 0 4 2 1 5 0 F F 3 E *

* / / 0 4 2 2 0 1 F F 3 E * * / / 0 4 2 2 0 3 F F 3 E *



Programming Bar Codes

G-8 Pegaso™ Industrial PDA with Windows® CE

2 4

* / / 0 4 2 2 0 2 F F 3 E * * / / 0 4 2 2 0 4 F F 3 E *
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Code 128

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

ENABLE UCC/EAN-128

On Off

ISBT CONCATENATION

On Off

MINIMUM LENGTH

1 30

2 40

10 50

20

* / / 0 4 0 8 1 F F 3 E * * / / 0 4 0 8 0 F F 3 E *

* / / 0 4 0 9 1 F F 3 E * * / / 0 4 0 9 0 F F 3 E *

* / / 0 4 0 C 1 F F 3 E * * / / 0 4 0 C 0 F F 3 E *

* / / 0 4 0 E 1 F F 3 E * * / / 0 4 0 E 0 F F 3 E *

* / / 0 4 2 4 0 1 F F 3 E * * / / 0 4 2 4 3 0 F F 3 E *

* / / 0 4 2 4 0 2 F F 3 E * * / / 0 4 2 4 4 0 F F 3 E *

* / / 0 4 2 4 1 0 F F 3 E * * / / 0 4 2 4 5 0 F F 3 E *

* / / 0 4 2 4 2 0 F F 3 E *
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EAN-13

MAXIMUM LENGTH

1 30

10 40

20 50

READ VERIFICATION

1 3

2 4

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

SEND CHECK DIGIT

On Off

* / / 0 4 2 5 0 1 F F 3 E * * / / 0 4 2 5 3 0 F F 3 E *

* / / 0 4 2 5 1 0 F F 3 E * * / / 0 4 2 5 4 0 F F 3 E *

* / / 0 4 2 5 2 0 F F 3 E * * / / 0 4 2 5 5 0 F F 3 E *

* / / 0 4 2 6 0 1 F F 3 E * * / / 0 4 2 6 0 3 F F 3 E *

* / / 0 4 2 6 0 2 F F 3 E * * / / 0 4 2 6 0 4 F F 3 E *

* / / 0 5 1 0 1 F F 3 E * * / / 0 5 1 0 0 F F 3 E *

* / / 0 5 1 1 1 F F 3 E * * / / 0 5 1 1 0 F F 3 E *

* / / 0 5 1 2 1 F F 3 E * * / / 0 5 1 2 0 F F 3 E *
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SEND SYSTEM DIGIT

On Off

CONVERT EAN-13 TO ISBN

On Off

CONVERT EAN-13 TO ISSN

On Off

ENABLE EAN 4-DIGIT PRICE/WEIGHT CHECK DIGIT

On Off

ENABLE EAN 5-DIGIT PRICE/WEIGHT CHECK DIGIT

On
O
f
f

Off

READ VERIFICATION

1 3

2 4

* / / 0 5 1 3 1 F F 3 E * * / / 0 5 1 3 0 F F 3 E *

* / / 0 5 1 4 1 F F 3 E * * / / 0 5 1 4 0 F F 3 E *

* / / 0 5 1 5 1 F F 3 E * * / / 0 5 1 5 0 F F 3 E *

* / / 0 5 1 6 1 F F 3 E * * / / 0 5 1 6 0 F F 3 E *

* / / 0 5 1 7 1 F F 3 E * * / / 0 5 1 7 0 F F 3 E *

* / / 0 5 2 4 0 1 F F 3 E * * / / 0 5 2 4 0 3 F F 3 E *

* / / 0 5 2 4 0 2 F F 3 E * * / / 0 5 2 6 0 4 F F 3 E *
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EAN-8

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

SEND CHECK DIGIT

On Off

CONVERT EAN-8 TO EAN-13

On Off

READ VERIFICATION

1 3

2 4

* / / 0 5 1 8 1 F F 3 E * * / / 0 5 1 8 0 F F 3 E *

* / / 0 5 1 9 1 F F 3 E * * / / 0 5 1 9 0 F F 3 E *

* / / 0 5 1 A 1 F F 3 E * * / / 0 5 1 A 0 F F 3 E *

* / / 0 5 1 B 1 F F 3 E * * / / 0 5 1 B 0 F F 3 E *

* / / 0 5 2 6 0 1 F F 3 E * * / / 0 5 2 6 0 3 F F 3 E *

* / / 0 5 2 6 0 2 F F 3 E * * / / 0 5 2 6 0 4 F F 3 E *
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Interleaved 2 of 5

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

ENABLE CHECKSUM

On Off

SEND CHECKSUM

On Off

ENABLE CASE CODE

On Off

MINIMUM LENGTH

2 30

6 40

10 50

20

* / / 0 2 1 0 1 F F 3 E * * / / 0 2 1 0 0 F F 3 E *

* / / 0 2 1 1 1 F F 3 E * * / / 0 2 1 1 0 F F 3 E *

* / / 0 2 1 2 1 F F 3 E * * / / 0 2 1 2 0 F F 3 E *

* / / 0 2 1 3 1 F F 3 E * * / / 0 2 1 3 0 F F 3 E *

* / / 0 2 1 4 1 F F 3 E * * / / 0 2 1 4 0 F F 3 E *

* / / 0 2 2 8 0 2 F F 3 E * * / / 0 2 2 8 3 0 F F 3 E *

* / / 0 2 2 8 0 6 F F 3 E * * / / 0 2 2 8 4 0 F F 3 E *

* / / 0 2 2 8 1 0 F F 3 E * * / / 0 2 2 8 5 0 F F 3 E *

* / / 0 2 2 8 2 0 F F 3 E *
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MAXIMUM LENGTH

2 30

10 40

20 50

READ VERIFICATION

1 3

2 4

* / / 0 2 2 9 0 2 F F 3 E * * / / 0 2 2 9 3 0 F F 3 E *

* / / 0 2 2 9 1 0 F F 3 E * * / / 0 2 2 9 4 0 F F 3 E *

* / / 0 2 2 9 2 0 F F 3 E * * / / 0 2 2 9 5 0 F F 3 E *

* / / 0 2 2 A 0 1 F F 3 E * * / / 0 2 2 A 0 3 F F 3 E *

* / / 0 2 2 A 0 2 F F 3 E * * / / 0 2 2 A 0 4 F F 3 E *
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Matrix 2 of 5

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

ENABLE CHECKSUM

On Off

SEND CHECKSUM

On Off

MINIMUM LENGTH

1 30

6 40

10 50

20

* / / 0 2 0 8 1 F F 3 E * * / / 0 2 0 8 0 F F 3 E *

* / / 0 2 0 9 0 F F 3 E * * / / 0 2 0 9 1 F F 3 E *

* / / 0 2 0 A 1 F F 3 E * * / / 0 2 0 A 0 F F 3 E *

* / / 0 2 0 B 1 F F 3 E * * / / 0 2 0 B 0 F F 3 E *

* / / 0 2 2 4 0 1 F F 3 E * * / / 0 2 2 4 3 0 F F 3 E *

* / / 0 2 2 4 0 6 F F 3 E * * / / 0 2 2 4 4 0 F F 3 E *

* / / 0 2 2 4 1 0 F F 3 E * * / / 0 2 2 4 5 0 F F 3 E *

* / / 0 2 2 4 2 0 F F 3 E *
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MAXIMUM LENGTH

1 30

10 40

20 50

READ VERIFICATION

1 3

2 4

* / / 0 2 2 5 0 1 F F 3 E * * / / 0 2 2 5 3 0 F F 3 E *

* / / 0 2 2 5 1 0 F F 3 E * * / / 0 2 2 5 4 0 F F 3 E *

* / / 0 2 2 5 2 0 F F 3 E * * / / 0 2 2 5 5 0 F F 3 E *

* / / 0 2 2 6 0 1 F F 3 E * * / / 0 2 2 6 0 3 F F 3 E *

* / / 0 2 2 6 0 2 F F 3 E * * / / 0 2 2 6 0 4 F F 3 E *
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MSI

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

REQUIRE 2 CHECK DIGITS

On Off

SEND CHECK DIGITS

On Off

2ND CHECK DIGIT MOD 11

On Off

MINIMUM LENGTH

1 10

4 12

7 15

* / / 0 6 0 8 1 F F 3 E * * / / 0 6 0 8 0 F F 3 E *

* / / 0 6 0 9 1 F F 3 E * * / / 0 6 0 9 0 F F 3 E *

* / / 0 6 0 A 1 F F 3 E * * / / 0 6 0 A 0 F F 3 E *

* / / 0 6 0 B 1 F F 3 E * * / / 0 6 0 B 0 F F 3 E *

* / / 0 6 0 C 1 F F 3 E * * / / 0 6 0 C 0 F F 3 E *

* / / 0 6 2 4 0 1 F F 3 E * * / / 0 6 2 4 1 0 F F 3 E *

* / / 0 6 2 4 0 4 F F 3 E * * / / 0 6 2 4 1 2 F F 3 E *

* / / 0 6 2 4 0 7 F F 3 E * * / / 0 6 2 4 1 5 F F 3 E *
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MAXIMUM LENGTH

1 10

4 12

7 15

READ VERIFICATION

1 3

2 4

* / / 0 6 2 5 0 1 F F 3 E * * / / 0 6 2 5 1 0 F F 3 E *

* / / 0 6 2 5 0 4 F F 3 E * * / / 0 6 2 5 1 2 F F 3 E *

* / / 0 6 2 5 0 7 F F 3 E * * / / 0 6 2 5 1 5 F F 3 E *

* / / 0 6 2 6 0 1 F F 3 E * * / / 0 6 2 6 0 3 F F 3 E *

* / / 0 6 2 6 0 2 F F 3 E * * / / 0 6 2 6 0 4 F F 3 E *
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Pharmacode 39 (Code 32)

RSS-14

RSS Limited

ENABLE

On Off

SEND CHECKSUM

On Off

SEND START/STOP

On Off

ENABLE

On Off

ENABLE RSS-14 to UCC-128

On Off

ENABLE

On Off

* / / 0 1 1 0 1 F F 3 E * * / / 0 1 1 0 0 F F 3 E *

* / / 0 1 1 2 1 F F 3 E * * / / 0 1 1 2 0 F F 3 E *

* / / 0 1 1 3 1 F F 3 E * * / / 0 1 1 3 0 F F 3 E *

* / / 0 8 0 0 1 F F 3 E * * / / 0 8 0 0 0 F F 3 E *

* / / 0 8 0 4 1 F F 3 E * * / / 0 8 0 4 0 F F 3 E *

* / / 0 8 0 8 1 F F 3 E * * / / 0 8 0 8 0 F F 3 E *
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ENABLE RSS Limited to UCC-128

On Off

* / / 0 8 0 C 1 F F 3 E * * / / 0 8 0 C 0 F F 3 E *
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RSS Expanded

ENABLE

On Off

ENABLE RSS Expanded to UCC-128

On Off

MINIMUM LENGTH

1 45

15 60

30 74

MAXIMUM LENGTH

1 45

15 6

30 74

* / / 0 8 1 0 1 F F 3 E * * / / 0 8 1 0 0 F F 3 E *

* / / 0 8 1 4 1 F F 3 E * * / / 0 8 1 4 0 F F 3 E *

* / / 0 8 2 4 0 1 F F 3 E * * / / 0 8 2 4 4 5 F F 3 E *

* / / 0 8 2 4 1 5 F F 3 E * * / / 0 8 2 4 6 0 F F 3 E *

* / / 0 8 2 4 3 0 F F 3 E * * / / 0 8 2 4 7 4 F F 3 E *

* / / 0 8 2 5 0 1 F F 3 E * * / / 0 8 2 5 4 5 F F 3 E *

* / / 0 8 2 5 1 5 F F 3 E * * / / 0 8 2 5 6 0 F F 3 E *

* / / 0 8 2 5 3 0 F F 3 E * * / / 0 8 2 5 7 4 F F 3 E *
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Standard 2 of 5

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

ENABLE CHECKSUM

On Off

SEND CHECKSUM

On Off

USE 2-BAR START/STOP

On Off

MINIMUM LENGTH

1 30

6 40

10 50

20

* / / 0 2 0 0 1 F F 3 E * * / / 0 2 0 0 0 F F 3 E *

* / / 0 2 0 1 1 F F 3 E * * / / 0 2 0 1 0 F F 3 E *

* / / 0 2 0 2 1 F F 3 E * * / / 0 2 0 2 0 F F 3 E *

* / / 0 2 0 3 1 F F 3 E * * / / 0 2 0 3 0 F F 3 E *

* / / 0 2 0 4 1 F F 3 E * * / / 0 2 0 4 0 F F 3 E *

* / / 0 2 2 0 0 1 F F 3 E * * / / 0 2 2 0 3 0 F F 3 E *

* / / 0 2 2 0 0 6 F F 3 E * * / / 0 2 2 0 4 0 F F 3 E *

* / / 0 2 2 0 1 0 F F 3 E * * / / 0 2 2 0 5 0 F F 3 E *

* / / 0 2 2 0 2 0 F F 3 E *
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Trioptic

MAXIMUM LENGTH

1 30

10 40

20 50

READ VERIFICATION

1 3

2 4

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

* / / 0 2 2 1 0 1 F F 3 E * * / / 0 2 2 1 3 0 F F 3 E *

* / / 0 2 2 1 1 0 F F 3 E * * / / 0 2 2 1 4 0 F F 3 E *

* / / 0 2 2 1 2 0 F F 3 E * * / / 0 2 2 1 5 0 F F 3 E *

* / / 0 2 2 2 0 1 F F 3 E * * / / 0 2 2 2 0 3 F F 3 E *

* / / 0 2 2 2 0 2 F F 3 E * * / / 0 2 2 2 0 4 F F 3 E *

* / / 0 1 0 8 1 F F 3 E * * / / 0 1 0 8 0 F F 3 E *

* / / 0 1 0 9 1 F F 3 E * * / / 0 1 0 9 0 F F 3 E *
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READ VERIFICATION

1 3

2 4

* / / 0 1 2 4 0 1 F F 3 E * * / / 0 1 2 4 0 3 F F 3 E *

* / / 0 1 2 4 0 2 F F 3 E * * / / 0 1 2 4 0 4 F F 3 E *
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UPC-A

ENABLE

On Off

ENABLE AGGRESSIVE DECODING

On Off

SEND CHECK DIGIT

On Off

SEND SYSTEM DIGIT

On Off

CONVERT UPC-A TO EAN-13

On Off

READ VERIFICATION

1 3

2 4

* / / 0 5 0 0 1 F F 3 E * * / / 0 5 0 0 0 F F 3 E *

* / / 0 5 0 1 1 F F 3 E * * / / 0 5 0 1 0 F F 3 E *

* / / 0 5 0 2 1 F F 3 E * * / / 0 5 0 2 0 F F 3 E *

* / / 0 5 0 3 1 F F 3 E * * / / 0 5 0 3 0 F F 3 E *

* / / 0 5 0 4 1 F F 3 E * * / / 0 5 0 4 0 F F 3 E *

* / / 0 5 2 0 0 1 F F 3 E * * / / 0 5 2 0 0 3 F F 3 E *

* / / 0 5 2 0 0 2 F F 3 E * * / / 0 5 2 0 0 4 F F 3 E *
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UPC-E

ENABLE SYSTEM DIGIT 0

On Off

ENABLE AGGRESSIVE DECODING

On Off

SEND CHECK DIGIT

On Off

SEND SYSTEM DIGIT

On Off

CONVERT UPC-E TO UPC-A

On Off

READ VERIFICATION

1 3

2 4

* / / 0 5 0 8 1 F F 3 E * * / / 0 5 0 8 0 F F 3 E *

* / / 0 5 0 9 1 F F 3 E * * / / 0 5 0 9 0 F F 3 E *

* / / 0 5 0 A 1 F F 3 E * * / / 0 5 0 A 0 F F 3 E *

* / / 0 5 0 B 1 F F 3 E * * / / 0 5 0 B 0 F F 3 E *

* / / 0 5 0 C 1 F F 3 E * * / / 0 5 0 C 0 F F 3 E *

* / / 0 5 2 2 0 1 F F 3 E * * / / 0 5 2 2 0 3 F F 3 E *

* / / 0 5 2 2 0 2 F F 3 E * * / / 0 5 2 2 0 4 F F 3 E *
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UPC/EAN Extensions

Other Controls

ENABLE 2-DIGIT EXTENSIONS

On Off

ENABLE 5-DIGIT EXTENSIONS

On Off

REQUIRE EXTENSIONS

On Off

READ VERIFICATION

1 3

2 4

* / / 0 5 1 C 1 F F 3 E * * / / 0 5 1 C 0 F F 3 E *

* / / 0 5 1 D 1 F F 3 E * * / / 0 5 1 D 0 F F 3 E *

* / / 0 5 1 F 1 F F 3 E * * / / 0 5 1 F 0 F F 3 E *

* / / 0 5 2 8 0 1 F F 3 E * * / / 0 5 2 8 0 3 F F 3 E *

* / / 0 5 2 8 0 2 F F 3 E * * / / 0 5 2 8 0 4 F F 3 E *

BEEPER VOLUME

Off

Lowest

Medium

* / / F F 2 0 0 0 F F 3 E *

* / / F F 2 0 0 1 F F 3 E *

* / / F F 2 0 0 4 F F 3 E *
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Highest

Higher 
(Increases the current 

value one increment 
higher)

Lower 
(Decreases the current 

value one increment lower)

NUMBER OF GOOD-READ BEEPS

1

2

3

4

GOOD-READ BEEP TONE

Lowest

Medium

Highest

* / / F F 2 0 0 7 F F 3 E *

* / / F F 2 0 0 8 F F 3 E *

* / / F F 2 0 0 9 F F 3 E *

* / / 0 0 2 0 0 1 F F 3 E *

* / / 0 0 2 0 0 2 F F 3 E *

* / / 0 0 2 0 0 3 F F 3 E *

* / / 0 0 2 0 0 4 F F 3 E *

* / / 0 0 2 1 0 0 F F 3 E *

* / / 0 0 2 1 0 3 F F 3 E *

* / / 0 0 2 1 0 7 F F 3 E *
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GOOD-READ BEEP DURATION (IN SECONDS)

0.07

0.13

0.18

0.36

Long Range Trigger Mode

Spot Timeout

Release Scan

Spotting Beam Enable

On

Off

Spotting Beam Timeout

0.25

0.5

* / / 0 0 2 2 0 0 F F 3 E *

* / / 0 2 2 0 0 1 F F 3 E *

* / / 0 0 2 2 0 2 F F 3 E *

* / / 0 0 2 2 0 3 F F 3 E *

* / / 0 0 0 0 0 F F 3 E *

* / / 0 0 0 0 1 F F 3 E *

* / / 0 0 0 1 1 F F 3 E *

* / / 0 0 0 1 0 F F 3 E *

* / / 0 0 2 3 0 0 F F 3 E *

* / / 0 2 2 0 0 1 F F 3 E *
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1.0

1.5

2.0

Release Scan Timeout (IN SECONDS)

1

2

3

5

10

* / / 0 0 2 3 0 2 F F 3 E *

* / / 0 0 2 3 0 3 F F 3 E *

* / / 0 0 2 3 0 4 F F 3 E *

* / / 0 0 2 4 0 1 F F 3 E *

* / / 0 0 2 4 0 2 F F 3 E *

* / / 0 0 2 4 0 3 F F 3 E *

* / / 0 0 2 4 0 5 F F 3 E *

* / / 0 0 2 4 1 0 F F 3 E *
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SEND SYMBOLOGY IDENTIFIERS

Off

DLM IDs

AIM IDs

User IDs

LABEL PREFIX

(CR)

(TAB)

None

LABEL SUFFIX

(CR)

(TAB)

None

* / / 0 0 2 5 0 0 F F 3 E *

* / / 0 0 2 5 0 1 F F 3 E *

* / / 0 0 2 5 0 2 F F 3 E *

* / / 0 0 2 5 0 3 F F 3 E *

* / / 0 0 2 6 $ M F F 3 E *

* / / 0 0 2 6 $ I F F 3 E *

* / / 0 0 2 6 % U F F 3 E *

* / / 0 0 2 7 $ M F F 3 E *

* / / 0 0 2 7 $ I F F 3 E *

* / / 0 0 2 7 % U F F 3 E *
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NOTES
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Appendix H
Glossary

Many definitions for this Glossary were taken directly from the Microsoft Developer’s 
Network website at http://msdn.microsoft.com/library/default.asp.

1D bar code
A traditional linear bar code. The code itself contains no information about the 
item to which it is assigned but represents a string of identifying numbers or let-
ters.

2D bar code

Two-dimensional (2D) bar codes permit the encoding of information about an 
item in addition to an identifying code. Two axes, or directions, are used for 
recording and reading the codes and the bar size is reduced, increasing the 
space available for data.

4-way rocker key Refer to "navigation key".

active notification
The state of a user notification from the time the user is notified until the user 
handles the event.

active window
The window in which a user is currently working or directing input. An active 
window is typically on top of the Z order and is distinguished by the color of its 
title bar. 

ActiveSync
Microsoft Windows Communication application that synchronizes a Windows 
CE device with a Microsoft Windows-based host PC. ActiveSync can use RS-
232, USB, and Wireless networks.

AP Access Point used for RF applications.

ASCII

American Standard Code for Information Interchange; a code for information 
exchange between computers made by different companies; a string of 7 binary 
digits represents each character; used in most microcomputers. Any member of 
the standard code for representing characters by binary numbers. Refer to 
Table F-5 on page F-15.

AutoCAB

The AutoCAB program allows the Pegaso to automatically reinstall selected 
applications when the terminal is cold reset. When the Pegaso is rebooted, the 
AutoCAB program runs automatically and determines if it is a warm or cold 
reset.

AutoCE

The AutoCE program allows the user to create a list of applications to run when 
the Pegaso is rebooted. Each application may be designated to run only on a 
cold reset, or on both warm and cold resets. The applications run sequentially, 
allowing interdependencies to be handled.

Batch units
Batch Pegaso units are synchronized and updated using Microsoft ActiveSync 
software and a dock for communication with the host PC.

http://msdn.microsoft.com/library/default.asp
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calibration
You may need to calibrate the touch screen. One way to know that the touch 
screen needs to be calibrated is that you will notice that when you attempt to 
select one item with the stylus, another item is erroneously selected.

checksum
A number used to verify the contents of a data file. This number is generated by 
calculating the contents of the data. If the calculated checksum is different from 
the expected checksum, the data has errors in it.

CLSI
CLSI, Inc., developer of the “LIBS 100 scanning and decoding system”. The 
“"Convert to CLSI"” parameter refers to formatting a Codabar bar code label in 
the manner defined by CLSI, Inc.

command band
A rebar control with a fixed band at the top that contains a toolbar with a Close 
(X) button, an OK button, and optionally a Help (?) button in the upper right cor-
ner.

command bar
A control window that can contain buttons, combo boxes, and menu bars. Win-
dows CE–based applications can use a command bar rather than a separate 
menubar and toolbar to efficiently use available screen space.

Concatenate To arrange (strings of characters) into a connected list.

control

A standardized part of the window that can be manipulated by the user to per-
form an action or display information. The most common controls are buttons 
that allow the user to select options and scroll bars that allow the user to move 
through a document or position text in a window.

context sensitive 
help

Tap “?” to open a help dialog about the specific windows application you are 
using. Context sensitive help can tell where you are in a program and can pro-
vide assistance with the specific problems you might be having.

control panel

Control Panels are several different applets that allow you to configure the 
Pegaso to meet your specific requires. There are control panels for scanning, 
keyboard, display, etc. Access the control panels at Start > Settings > Control 
Panel.

device manager

A tool to track all loaded device drivers and their interfaces. It issues notification 
of the appearance, disappearance of device interfaces, loads and tracks drivers 
by reading and writing registry values, and unloads drivers when their devices 
are no longer needed. 

device partnership

A registry key on a "Windows CE" device that a desktop computer uses to iden-
tify the device when it is connected. The key defines values for synchronization, 
file conversions, and backup and restore information, which enable multiple 
"Windows CE" devices to connect to the same desktop computer. A device part-
nership is created the first time you connect a "Windows CE" device to a host 
PC.

embedded 
Broadly, software code or commands built into a device, as opposed to software 
that is added. In a narrower sense, code that is typically stored in ROM and ded-
icated to either controlling a device or providing a specific functionality.

FAST
Part of Datalogic Mobile’s "Falcon Management Utility (FMU)" application for the 
Pegaso that updates the operating system and applications automatically from 
a server using the wireless network system.

firmware Operating System on the Pegaso.
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FlashFX
Persistent Flash Memory management system made by Datalight™. Data in the 
flash memory is retained when a battery pack is fully discharged. The backup 
battery must be charged to retain flash memory.

Falcon Desktop 
Utility (FDU)

Falcon® Desktop Utility (FDU) allows Datalogic Mobile Windows® administra-
tors to configure Windows®CE Pegasos to control individual user access.

Falcon Manage-
ment Utility (FMU)

A Datalogic Windows-based management application for managing the configu-
ration settings and updating the operating system and applications automati-
cally from a server using the wireless network system on the Pegaso.

Firmware Update 
Utility (FUU)

A Datalogic Windows-based field upgradeable firmware mechanism. Use the 
Firmware Update Utility (FUU), described starting on page 3-8, to install or 
update the firmware using an "ActiveSync" connection. 

gripper bar

A gripper bar is a tall, thin rectangle with a dark stripe running through it that 
appears on a rebar or a command band control. By touching and dragging a 
gripper bar with a stylus, a user can reposition a rebar or command bar. Gripper 
bars are especially useful for bringing off-screen rebar or command bar controls 
into view.

host PC system
PC using the Microsoft Windows operating system and "Falcon Management 
Utility (FMU)" and/or "ActiveSync".

Infrared Data Asso-
ciation 

The industry organization of computer, component, and telecommunications 
vendors who have established the standards for infrared communication 
between computers and peripheral devices such as printers. Windows CE sup-
ports the IrDA standard through the Winsock API. Windows CE–based applica-
tions that communicate over serial cables using the Winsock API communicate 
over IrDA-compliant infrared links with only minimal reprogramming.

input method (IM) A component that allows the user to input text using a touch screen.

input panel Refer to "soft input panel (SIP)".

ISBN

International Standard Book Number. A unique number assigned to each book 
to allow ease of ordering from any source: local bookstore, online book dealers, 
or directly from the publisher. The ISBN number is usually printed on the back 
cover of a book near the bar code, but can also appear within the book.

ISSN

International Standard Serial Number. An ISSN consists of eight digits compris-
ing two groups of four digits each, separated by a hyphen. The eighth digit is a 
check digit used as a computer validity check; it consists of a number between 0 
and 9 or an uppercase X (for the arabic numeral 10).

MIB (Management 
Information Base)

A Management Information Base (MIB) is a file that defines a set of "SNMP 
(Simple Network Management Protocol)" variables, their types and usage. 
There are a number of standard MIBs available, depending on the information 
being managed. The MIB is used by the management tools to allow them to bet-
ter support the configuration values provided on the terminals, such as scanner 
controls and terminal type information. 

mounted file sys-
tem

A file system located on a removable medium, such as a PC Card storage 
device. The operating system loads, or mounts, the file system when the 
medium is inserted into the device. It unloads, or unmounts, the file system 
when the medium is removed or when the user issues a command to do so.
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navigation key

A large navigation button (4-way rocker key) on the keypad with 4 arrows: point-
ing up, down, left, and right that allows the user to move the cursor or high-
lighted text entry during menu selection. Press and release one edge of the key 
to move the display screen one line or one character in the direction of the 
arrow. 

Network ID
Here used to mean that you should configure the Windows user settings, such 
as the user name, password, and domain name. Microsoft’s definition includes 
some wireless network IDs as equivalent to SSIDs.

non-persistent 
state

A non-persistent state affects only the next keypress. FN state is a non-persis-
tent state.

object store

The persistent storage that Windows CE makes available to applications. For 
example, Windows CE reserves part of its available RAM for the operating sys-
tem and uses the rest for the object store. This data can be stored in files, regis-
try entries, or Windows CE databases.

portable data 
assistant (PDA)

A handheld Windows-based (Pocket-PC or Windows CE) computer that can be 
synchronized with a host PC to share files and data. Sometimes contains an 
infrared device to beam information to another unit.

portable data ter-
minal (PDT)

An industrial strength handheld computer with a keypad, navigation keys, and a 
bar code scanner used in inventory, retail, and warehouse activities to collect 
data and upload it to a host PC.

Persistent Memory
Persistent Memory is the Pegaso’s flash application and file storage area.  
The persistent storage memory persists across all reset (warm/cold reboot) 
conditions and software / firmware updates.

persistent state
A state which is maintained after releasing a key. Alpha mode is a persistent 
mode. Also called a “sticky” state. A persistent state must be turned off by 
pressing the key again.

PRG Product Reference Guide.

program memory
Memory that is used for stack and heap storage for both system and nonsystem 
applications. Nonsystem applications are taken from storage memory, uncom-
pressed, and loaded into program memory for execution.

RF card
A small card-shaped device installed in a Pegaso that allows wireless connec-
tion and communication with a network.

QSG Quick Start Guide.

RAM (random 
access memory)

You can add applications and data files to RAM or into Flash memory via the 
"FlashFX" Disk. While Flash memory is persistent (as long as the backup bat-
tery is charged), RAM is not and will be cleared when you remove or replace the 
battery. As you can only suspend the device, the only way to turn it fully off is to 
remove the battery or to perform a cold reset.

ROM (read only 
memory)

The operating system ("Windows CE") and applications are pre-installed on 
ROM and cannot be removed or modified. These applications are persistent.

rebar A command bar with a gripper bar.
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remote access 
server (RAS)

A feature that connects a device to a host computer. Windows CE can connect 
to a remote access server using direct serial, infrared, and dial-up connections. 
Windows CE supports the standard Microsoft Win32 RAS functions; however, it 
allows only one connection at a time. RAS functions can be implemented for 
direct serial connections or dial-up modem connections.

RTC Real Time Clock on the PC.

shortcut menu
A menu that is displayed for a selected object. The menu contains commands 
that are contextually relevant to the selection.

SNMP (Simple Net-
work Management 
Protocol)

SNMP is the standard protocol for managing devices on a network. Simple Net-
work Management Protocol (SNMP) is a standardized protocol for network 
management services using a client/server model. The network management 
program (client) issues queries and commands to the remote device 

soft input panel 
(SIP)

Click on the Keyboard icon in the system tray to open the SIP. Use this virtual 
QWERTY keyboard like you would a computer’s keypad to enter alpha numeric 
and symbols in the current application.

splash screen
An initial screen displayed by software, usually containing a logo, version infor-
mation, author credits, or a copyright notice.

start 
The start button opens the Start menu. The Start menu contains a list of the res-
ident applications, applets, and utilities available to the user.

status bar
An area that displays state information for the content in the window, typically 
placed at the bottom of a window. 

status icons A graphic representation of the status of a feature or function.

stylus

The stylus is the equivalent of a mouse on the Pegaso. Use the stylus on a 
touch-sensitive display. Only a plastic tipped stylus should be used on a touch-
sensitive display. 

Use the stylus to navigate the "touchscreen display", select characters in the 
soft input panel (SIP), select applications from the desktop or system tray, select 
tabs, fields and text within applications and dialog boxes.

suspend mode

The Pegaso will go into a suspend or sleep mode when it is idle for a period of 
time. Suspend mode works and looks just like you have turned the unit off. 
Press <Power> to suspend (put to sleep) the Pegaso. Press <Power> again for 
the Pegaso to resume its previous state.

Symbology

A symbology is a protocol for arranging the bars and spaces that make up a par-
ticular kind of bar code. A bar code is made up of numbers, letters, and com-
puter-recognized characters that can be represented in a combination of bars 
and spaces. There is not one standard bar code; there are currently over 400 
bar code symbologies that serve different uses, industries, or geographic needs.

system tray
An area of the display screen located at the bottom, within the Task bar that dis-
plays status icons and symbols.

system tray key-
board Indicators 

The System Tray Keyboard Indicators are located at the bottom of the display in 
the "task bar" and contain "status icons" and symbols indicating open features 
and active applets.
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task bar

The Task bar at the bottom of the screen displays the "start" icon, an icon for the 
active program, an icon for the current character, the current time, and system 
icons for utilities loaded in memory, including the keyboard icon, which opens 
and closes the "soft input panel (SIP)".

touchscreen dis-
play

A graphical computer interface display screen that allows the user to enter and 
select items with a "stylus".

Tracert Trace Route. A utility/command to determine TCP/IP packet routing. 

Uniform Resource 
Locator (URL)

The address of a resource on the Internet. URL syntax is in the form protocol://
host/localinfo, where protocol specifies the means of returning the object, such 
as HTTP or FTP. Host specifies the remote location where the object resides 
and localinfo is a string, often a file name, passed to the protocol handler at the 
remote location. Also called a Uniform Resource Identifier.

USB 
Universal Serial Bus is a protocol for connecting PCs with peripheral devices, 
including PDTs, PDAs, Pegaso mobile computers, cameras, printers, mice, 
scanners, etc.

Web Server

The web server can perform several different actions, including generating a 
web page containing statistics relating to performance of the mobile computer 
and creating an interface for interaction with the terminal to configure system 
behavior.

Windows CE 
As per Microsoft, Windows CE combines an advanced real-time embedded 
operating system with the most powerful tools for rapidly creating the next gen-
eration of smart, connected, and small-footprint devices.

XPING
XPing is a protocol that sends a message to another computer and waits for 
acknowledgment, often used to check if another computer on a network is 
reachable.
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... (browse) B-9, B-12
.exe files 3-6

NUMERICS
400 Invalid Syntax B-8
403 Request Forbidden B-8
404 Object Not Found B-8
406 No Response Format B-8
410 Page Doesn’t Exist B-8
4-way rocker key H-1
500 Internal Server Error B-8
501 Server Can’t Do That B-8

A
Accessories A-1
accessories

handle A-8
handstrap A-8
overview A-1

action B-6, B-13
active notification H-1
active window H-1
ActiveSync H-1

connection 3-8, 3-10, H-3
copying files using 3-6
file synchronization 4-6
installation 4-2
installing 4-1, 4-3
network setup 4-9
partnership 4-5
purpose 4-1
remote 4-9
settings 4-7
setup 4-1
Start Menu 3-7
transferring files 4-5
using 4-5

version 4-1
version required 4-1

add
new hotkey B-7
program B-11

address bar, enable B-9
Admin tab B-3
alignment, touchscreen 2-22
and 3-4
application B-6

adding B-11
authorized B-11
enable selector B-11
selector B-11, B-13
title B-12

applications 3-1
adding 3-5
overview 3-1
reboot list H-1
removing 3-7

AppSelect tab B-11
arguments B-6, B-12
Assign as Default B-9
associated function B-6
audio, decoding properties 2-8
authorized applications B-11
AutoCAB H-1
AutoCE H-1
Autoexec.ini 3-14
AutoStart 3-12

Autostart.ini 3-14
Installing CAB files 3-13
Wceload 3-13

Autostart.ini 3-14

B
backlight 2-2
bar codes

codabar G-9
code 128 G-9
code 39 G-5
code 93 G-7
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decoding 2-9
EAN-13 G-10
EAN-8 G-12
interleaved 2 of 5 G-13
label suffix G-31
matrix 2 of 5 G-15
MSI G-17
parameters F-3
Pharmacode 39 (Code 32) G-19
predefined defaults G-2
programming G-1
RSS G-19, G-21
standard 2 of 5 G-22
symbologies 2-8, 2-9, 2-10
trioptic G-23
UPC/EAN extensions G-27
UPC-A G-25
UPC-E G-26
without parameters F-2

battery
CAUTIONS 1-3
disposal 1-3
failure 1-3

window 1-3
lithium-ion 1-3
tab 2-20
WARNINGS 1-2

Battery Pack A-2
beep

duration, good-read F-14, G-29
good-read number F-14, G-28
tone, good-read F-14, G-28
volume F-14, G-27

beeps twice on reboot 3-11
Belt Clip A-10
button

new B-11
OK B-2, B-5, B-7, B-12
X B-2, B-5, B-7, B-12

C
CAB files

Installing 3-13
Interactive 3-13

cab files 3-5, 3-6
cable

serial E-2
calibration H-2

control panel 2-23
touchscreen 2-22

Car Charging Adapter A-5
checksum H-2
clicking i-vii, 4-3

codabar 2-10, F-3, G-9
code 128 2-10, F-5, G-9
code 39 2-10, F-4, G-5
code 93 2-10, F-4, G-7
code parameters F-1, F-2
cold reset

reinstall applications 3-12, H-1
command band H-2
command bar H-2
communication

overview 4-1
configuration

backlight 2-2
decoding 2-7

general tab 2-7
symbologies tab 2-10

display 2-11
memory 2-24
overview 2-1
power 2-20
settings 2-1
sounds 2-25
volume 2-25

configure
connectors E-1

connect to new device 4-3
connection

dialup 2-17, 4-8
network 2-17, 4-8
overview 4-1

connector configurations E-1
context sensitive help H-2
control H-2
control panel 2-1, H-2

backlight 2-2
battery 2-20
calibration 2-23
date/time 2-6
decoding 2-7

options 2-8, 2-9, 2-10
display 2-11
internet 2-14
keypad 2-16
owner 2-18
password 2-18
power 2-20
power gauge 2-20
regional settings 2-21
system 2-24
volume & sounds 2-25

controls, other F-14
copyrights 2-25
corrupted firmware 3-8
Couldn't Find Server B-8
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D
Datalogic.bmp 2-11
date, setting 2-6
decoding

configuration 2-7
decoding options 2-9
decoding properties 2-8, 2-9

audio 2-8
configure 2-7
decoding options 2-9
devices 2-9
general options 2-8
settings 2-7

default parameters F-1
factory F-1, F-2
maximum F-1, F-2
minimum F-1, F-2
predefined, bar codes G-2
registry F-2

defaults, restore B-3, B-4
delay B-12
delete B-6, B-11
desktop B-9
device 2-9

name 2-25
device manager H-2
device partnership H-2
DHCP 2-17
dialup connections 2-17, 4-8
display

configuration 2-11
control panel 2-11

DNS 2-17
dock

which Datalogic dock to use A-2
document

conventions i-vi
overview i-v

domain 4-8
double-click i-vii
double-tap i-vii
driver

USB 4-4

E
EAN-13 2-10, F-6, G-10
EAN-8 2-10, F-6, G-12
edit B-11
email application 3-2
embedded H-2
enable 2-10

address bar B-9
application selector B-11

checksum 2-10
Falcon Desktop B-3
menu bar B-9
read-ahead 2-9
status bar B-9
tool bar B-9

enter key B-7
error

400 Invalid Syntax B-8
403 Request Forbidden B-8
404 Object Not Found B-8
501 Server Can’t Do That B-8
Couldn’t Find Server B-8
generic B-8
Generic Error B-8
Not Available Offline B-8
page B-8
Request Cancelled B-8
Server Is Busy B-8
type B-8

(406) No Response Format B-8
URL Syntax Error B-8

Error Type
(410) Page Doesn’t Exist B-8
(500) Internal Server Error B-8

Ethernet Module A-7
exe files 3-5, 3-6
exit and

commit F-2
restore F-2
save F-2

expansion card 2-24
explore mobile device 4-5
Explorer

Internet 3-2, 3-3
Windows 3-7

F
F2 key B-5
factory G-2
failure, battery 1-3
Falcon Desktop Utility B-2
Falcon Management Utility 2-13, 3-8, 4-9, H-3
FAST H-2
FDU Config B-5
file

cab 3-5, 3-6
Datalogic.bmp 2-11
exe 3-5, 3-6
MIB D-1
ReadMe 3-6
setup.exe 3-6
synchronization 4-6
transferring with ActiveSync 4-5
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zip 3-5, 3-6
file icons B-12
firmware H-2

aborting update 3-11
restoration 3-8
retrieving image 3-8
updates link 3-8
updating 3-10

Firmware Update Utility 3-8, H-3
FlashFX H-3
FMU 2-13
formatting conventions i-vi
Four-Slot Battery Charger A-5
Four-Slot Charge Dock A-4
Four-Slot Ethernet Dock A-4
Full ASCII conversion 2-10
FUU 3-8, H-3

restoring firmware 3-8

G
general options 2-8

decoding control panel 2-8, 2-9, 2-10
generic error B-8
glossary H-1
good-read

beep duration F-14, G-29
beep tone F-14, G-28
number of beeps F-14, G-28

gripper bar H-3

H
Handle A-8

removing A-9
Handstrap A-7
handstrap

installing A-8
host PC system H-3
hotkey B-5, B-6, B-13

add new B-7
new B-6

I
I.D. # F-2
icons

file B-12
input state H-5
status H-5
system tray H-5

IE Tab B-8
Inbox 3-2

Infrared Data Association H-3
input method H-3
input panel H-3
installation

ActiveSync 4-2
handstrap A-8
software 3-6
wizard 3-6

installing
ActiveSync 4-3

interleaved 2 of 5 2-10, F-7, F-8, G-13
Internet Explorer 3-2, 3-3, B-8

redirection B-8
internet options B-9
internet settings 2-14
IP

address 2-17

K
key

F2 B-5
hot B-6
navigation H-4
strokes entered by user i-vi

keypad
options 2-16
overview B-1

L
label

prefix 2-8
programming 2-8
suffix 2-8

long range trigger mode F-14

M
magnetic stripe reader 2-9
manual, how to use i-v
matrix 2 of 5 G-15
maximum default settings G-2
memory

allocation 2-24
configuration 2-24
RAM 3-5
read-only 3-5
ROM 3-5
TrueFFS Disk 3-4
usage 2-24

Memory, persistent 3-4
menu bar, enable B-9
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MIB H-3
Datalogic D-1
files D-1

min/max lengths 2-10
minimum default settings G-2
mobile device 4-4

explore 4-5
mode

resume 1-1
suspend 1-1

Modem A-6
Modem Module A-6
mounted file system H-3
mouse

click i-vii
double-click i-vii
right click i-vii
select i-vii
using i-vii

MSI F-8, G-17
my documents 4-7

N
name servers 2-17
navigation key H-4
Network

ID H-4
network

ActiveSync setup 4-9
connections 2-17, 4-8
ID 4-8
overview 4-1
setup ID 4-8

networking 4-8
new B-11

button B-11
hotkey B-6

non-persistent state H-4
Not Available Offline B-8
note B-7

O
object store H-4
OK button B-2, B-5, B-7, B-12
options, internet B-9
other controls F-14
overview B-1
overview, manual i-v
owner properties 4-8
owner settings 2-18

P
parameters

acceptable input F-1
bar codes F-3
bar codes without F-2
codabar F-3
code 128 F-5
code 39 F-4
code 93 F-4
code parameters F-1
default F-1
EAN-13 F-6
EAN-8 F-6
ID# F-1
interleaved 2 of 5 F-7, F-8
label prefix F-15, G-31
label suffix F-15
MSI F-8
on/off F-1
Pharmacode 39 (Code 32) F-9
programming F-1
standard 2 of 5 F-11
trioptic F-11
UPC/EAN extensions F-13
UPC-A F-12
UPC-E F-12

partnership
setting up 4-5

password 4-8, B-3, B-4
enter B-5
re-enter B-4
request B-4
set B-3, B-4
settings 2-18

PC card, expansion 2-24
Pegaso

dock A-2
power 1-1

persistent
state H-4

Persistent Memory 3-4
Persistent Registry 2-19
Pharmacode 39 (Code 32) 2-10, F-9, G-19
pinouts E-1
portable data assistant (PDA) H-4
portable data terminal (PDT) H-4
portable keys i-vi
portables

keys i-vi
power 1-1

check battery 2-20
configuration 2-20
control panel 2-20
power off tab 2-20

Power Supplies A-2
Power Supply A-2
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product registration i-vi
program memory H-4
program, adding B-11
programming

bar codes G-1
parameters F-1

programs
adding to the start menu 3-7
installing 3-5
removing 3-7

R
RAM 2-24, H-4
ReadMe files 3-6
rebar H-4
reboot

after restoring firmware 3-12
application list H-1

regional settings 2-21
registry defaults G-2
reinstall applications from cold boot 3-12, H-1
release scan timeout F-14
remote access server (RAS) H-5
remote ActiveSync 4-9
removing applications 3-7
Request Cancelled B-8
restore

firmware 3-12
from registry G-2

restore defaults B-3, B-4
resume 1-1
RF

card H-4
configuration 4-8

RFID 2-9
right click i-vii
ROM H-4
RSS-14 G-19, G-21
RTC H-5
Run Program on Startup B-12

S
save to registry G-2
Screen Protector A-12
SDCCF10G1 2-17
select

with a mouse i-vii
with the stylus i-vii

selector
application B-11, B-13
enable application B-11

send

check digit 2-10
checksum 2-10
system digit 2-10

serial
number 2-11, 2-24

serial cable E-2
serial number 2-11
Server Is Busy B-8
set ID character 2-9
set password B-3, B-4
settings

control panel 2-1
date and time 2-6
internet 2-14
modifying 2-1
regional 2-21

setup 3-6
network ID 4-8
network with ActiveSync 4-9

shortcut 3-7
menu H-5

Show Taskbar B-10
Single Slot Dock A-3
SNMP 4-9, H-5

concepts D-1
soft input panel H-5

properties 2-13
software 3-1

installation 3-6
sound tab 2-26
sounds 2-25
splash screen H-5
spotting beam

enable F-14
timeout F-14

standard 2 of 5 2-10, F-11, G-22
start button H-5
start menu, adding programs to 3-7
static IP settings 2-17
status

bar H-5
bar, enable B-9
icons H-5

style conventions i-vi
stylus H-5

actions i-vii
properties 2-22

Summit Client Utility 2-26
suspend mode 1-1, H-5
symbologies 2-9

bar code 2-8, 2-9, 2-10
codabar F-3, G-9
code 128 F-5, G-9
code 39 F-4, G-5
code 93 F-4, G-7
EAN-13 F-6, G-10
EAN-8 F-6, G-12
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Pharmacode 39 (Code 32) F-9, G-19
RSS G-19, G-21
send identifiers F-14, G-31
standard 2 of 5 F-11, G-22
trioptic F-11, G-23
UPC/EAN extensions F-13, G-27
UPC-A F-12, G-25
UPC-E F-12, G-26

synchronization folder 4-7
synchronizing files 4-6
system

firmware version 2-24
properties 2-24
serial number 2-24

system tray H-5
icons H-5
keyboard Indicators H-5
keyboard indicators H-5

T
tap stylus i-vii
task bar B-9, H-6

enabled B-10
task switcher B-13
time, setting 2-6
title

application B-12
touchscreen display

alignment 2-22
calibration 2-22

trioptic 2-10, F-11, G-23
TrueFFS Disk

location 3-4
using 3-4

two beeps on reboot 3-11

U
unauthorized use B-9
Uniform Resource Locator (URL) H-6
Up/Down B-11
UPC/EAN Extensions 2-10

UPC/EAN extensions F-13, G-27
UPC-A 2-10, F-12, G-25
UPC-E F-12, G-26
URL 2-14

Syntax Error B-8
USB H-6

driver 4-4
USB Cable A-2
user IDs 2-9
user name 4-8
using

a mouse i-vii
ActiveSync 4-5

V
version

ActiveSync 4-1
volume

adjusting 2-25
beeper F-14, G-27
tab 2-26

W
wake up 1-2
Wceload 3-13
Win tab B-9
Windows

Explorer 3-7
Windows CE .NET H-6
Windows CE Desktop Enabled B-10
windows controls i-vi, B-9
WINS 2-17
wizard, installation 3-6
WordPad 3-3

X
X button B-2, B-5, B-7, B-12

Z
zip files 3-5, 3-6



I-8 Pegaso™ Industrial PDA with Windows® CE

Index

NOTES





Corporate Headquarters 
Datalogic S.p.A. 
Via Candini, 2 
40012 Lippo di Calderara di Reno 
Bologna - Italy 
Telephone: +39 051 3147011 
Fax: +39 051 726562

Datalogic Mobile, Inc.
1505 Westec Dr.
Eugene, OR 97402
Telephone: (541) 743-4800
Fax: (541) 743-4900

www.mobile.datalogic.com

©2007 Datalogic Mobile, Inc. R44-2577 (Rev A) 09/07

http://www.mobile.datalogic.com

	Preface: About this Guide
	How to Use this Manual
	Document Conventions

	Batteries and Power
	Overview
	Suspend Mode
	Suspending
	Resuming

	Battery Warnings and Cautions
	Battery Disposal

	Configuring the Pegaso
	Overview
	Backlight
	Brightness
	Auto-Off
	Activation

	Bluetooth Manager
	Search for device
	Connect to a Bluetooth Device
	Viewing or Deleting Paired Devices
	Settings

	Certificates
	Date and Time
	Decoding
	Configuration Control Panels

	Device Info
	Display Configuration
	Background
	Appearance
	Settings

	Error Reporting
	Falcon Config
	Input Panel Properties
	Internet Options
	Keyboard Configuration
	Network and Dialup
	Owner
	Password
	PC Connection
	Persistent Registry
	Power Configuration
	Regional Settings
	Remove Programs
	Storage Manager
	Stylus Calibration
	System Properties
	General Tab
	Memory Configuration
	Device Name
	Copyrights

	Volume and Sounds
	Wi-FI
	Using the Summit Client Utility
	SCU Windows


	Software Applications
	Overview
	Inbox
	Internet Explorer
	Media Player
	WordPad
	Persistent Memory
	Saving to Persistent Memory
	Location
	Disk Size

	Installing Programs
	Using an Installation Wizard
	Installing Programs Manually
	Using Windows Explorer to Add to the Start Menu
	Using ActiveSync to Add to the Start Menu

	Removing Programs
	Firmware Update Utility
	Retrieving a Firmware Image Update
	Installing FUU on the Host PC
	Updating the Pegaso Firmware
	Restoring Pegaso Firmware

	AutoStart
	Installing CAB files
	Autostart.ini


	Networks, Communications, and Connections
	Overview
	Installing & Setting Up Microsoft ActiveSync
	Installing Microsoft ActiveSync
	Setting up ActiveSync

	Installing the USB Driver
	Using ActiveSync
	Setting up a Partnership
	Transferring Files
	File Synchronizing using ActiveSync

	Networking
	Setting up the Network ID
	The Network Icon
	Network and Dialup Connections
	Network Setup: Remote ActiveSync

	SNMP

	Accessories
	Overview
	Power Supplies
	Powered USB Cable & Power Supply
	Battery Pack
	Single Slot Dock
	Four-Slot Charge Dock
	Four-Slot Ethernet Dock
	Four-Slot Battery Charger
	Car Charging Adapter

	Modem Module
	Ethernet Module
	Handstrap
	Removing the Handstrap
	Installing the Handstrap

	Handle
	Installing a Handle on the Pegaso

	Belt Clip
	Attaching to a Belt

	Screen Protector

	Falcon® Desktop Utility for Windows® CE
	Overview
	Falcon Desktop Utility
	Administrative Options
	Setting a Password
	Changing a Password
	Removing a Password
	Password Request Dialog Box
	Setting Hot Keys
	Internet Explorer Configuration
	Modifying Windows Controls

	Application Selector
	Add Application

	Application Selector
	Application Switcher User Interface

	Configuring the Web Server
	Overview
	Enabling the Web Server
	Setting up a User
	Testing the Web Server
	Launching the Network Administration Page
	Web Server Registry Settings
	Creating and Using an ISAPI Service

	SNMP Interface
	Overview
	SNMP Concepts
	MIB Files
	Additional Resources


	Cable & Connector Configurations
	Introduction
	General Specifications
	Wire Requirements
	Supply Voltage

	Docking Connector
	USB Cable

	Programming Parameters
	Overview
	Programming Codes Without Parameters
	Bar Code Parameters

	Programming Bar Codes
	Overview
	Predefined Defaults
	Codabar
	Code 39
	Code 93
	Code 128
	EAN-13
	EAN-8
	Interleaved 2 of 5
	Matrix 2 of 5
	MSI
	Pharmacode 39 (Code 32)
	RSS-14
	RSS Limited
	RSS Expanded
	Standard 2 of 5
	Trioptic
	UPC-A
	UPC-E
	UPC/EAN Extensions
	Other Controls

	Glossary
	Symbols
	Numerics
	A
	B
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W
	X
	Z


